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1 INTRODUCTION 

1.1 About this Document  

1.1.1 This document refers to Chapter 4, Section 2.2, of the NATO Architecture Framework (NAF) 
version 4.1. It provides guidance on how to develop NAFv4.1 compliant architectures based 
on the ArchiMate 3.2 specification. 

1.1.2 The NATO Architecture Framework document concerns all nations or organizations using the 
NAF. It is provided and maintained by the NATO Architecture Capability Team (ACaT). The 
ArchiMate implementation guide (i.e. this document) concern all nations or organizations 
using the ArchiMate modelling language for their architecture development. Because tools 
and specific extensions of framework and language may differ between nations or 
organizations, these aspects are not considered in this document. Nations or organizations 
need to provide and maintain additional guidelines in order to cover these aspects 
themselves. 

1.2 Design Principles 

1.2.1 This document provides an ArchiMate‑based implementation of the NAFv4.1 Information 
Model (NAF IM). The following design principles guided its development: 
• Conciseness - Only ArchiMate elements and relationships necessary to represent the 

NAFv4.1 Information Model and its viewpoints are included. Redundant or rarely used 
constructs are intentionally omitted to improve modelling clarity and reduce 
complexity. 

• Flexibility - Where necessary, ArchiMate concepts have been specialized to represent 
NAF‑specific semantics accurately and to ensure the metamodel reflects the intent of 
the NAFv4.1 Information Model. 

• Usability - The model prioritises clear semantics and unambiguous representation of 
architectural concepts, ensuring that architects can interpret and apply the specialized 
ArchiMate elements confidently and consistently. 

• Alignment – The implementation aligns closely with the NAFv4.1 Information Model, 
adapting ArchiMate where required to represent NAF concepts with the correct 
semantics. The objective is to deliver a consistent and faithful ArchiMate representation 
of NAFv4.1, rather than a full replication of either metamodel. It is not intended to be a 
1:1 mapping of the ArchiMate specification to NAFv4.1 IM.  

1.2.2 Addressed readers are  
• Modellers required to produce NAFv4 compliant ArchiMate Models. 
• Developers of national/organizational guidelines. 
• Implementers of tool specific ArchiMate profiles. 

1.2.3 Programme‑level architects may use this guidance but retain the discretion to extend or 
tailor the metamodel to suit programme needs. Given typical constraints on time, resources 
and scope, they are expected to produce a minimum viable architecture aligned with the 
NAFv4.1 Information Model, rather than exhaustively constructing every viewpoint 
described in this guide. 
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2 ARCHIMATE AND NAF 

2.1 The NAFv4 Viewpoints 

2.1.1 The NAF Grid is detailed in Chapter 2, Section 2 of the NAFv4.1. It is a two-dimensional 
classification scheme for the standardized NAF viewpoints, which serve as the baseline for 
any NAF-Compliant architecture effort.  

2.1.2 The grid approach presents the NAF viewpoints by Subjects of Concerns (rows) and by 
Aspects of Concerns (columns). The NAF is arranged as a grid with columns as set of broad 
Model Kinds.  

2.2 ArchiMate NAF Grid Overlay  

2.2.1 The ArchiMate Full Framework captures the viewpoints in the NAF Grid thusly; 
 
 

 
 
2.2.2 Aspects from the ArchiMate Full Framework do not align explicitly to the viewpoints, 

however, the shading of the vertical ‘aspects’ related to the fact that encapsulated 
viewpoints emphasize the use of objects from these aspects, but are not limited to them. 
Whilst in some cases there are terms in both NAF and ArchiMate that share the same 
meaning, others do not. Care must be taken to understand which term the document is 
referring to at any point in time, for example; Technology, Physical, Resource and Node etc. 

2.2.3 Due to the use of ArchiMate concepts in multiple layers within the NAF Grid, the 
specialization of ArchiMate concepts is required. 
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2.3 Specialisms 

2.3.1 Specializing the ArchiMate metamodel is a necessity, and as such, all elements within this 
document should be viewed as specialisms of the standard ArchiMate specification with 
some elements with the only distinction being in how much the specialisms deviate from the 
standard. 

2.3.2 Specialization addresses both; 
• gaps in aligning the standard ArchiMate framework and NAFv4.1, and, in future 
• exchange between different modelling languages 

2.3.3 By tailoring ArchiMate elements to represent NAF-specific constructs, the resultant 
specialized NAFV4.1 ArchiMate Metamodel becomes more effective and relevant for its 
intended purpose. This specialization is fully supported by the ArchiMate specification, 
ensuring compliance while enabling enhanced clarity and usability.  

2.3.4 There is a many to many mapping between the Information Model elements and ArchiMate 
specialisms. This is because of either the natural extension of ArchiMate in some areas e.g. 
layering (business, application, technology) or because the definition of the IM elements 
map to multiple ArchiMate elements, e.g. the IM Goal is defined as “An aim or outcome..” 
which nicely maps onto the ArchiMate goal and/or the ArchiMate outcome depending on 
the context. 

2.3.5 However, nations or organizations seeking consistency across multiple programmes, 
projects, or tool implementations may further constrain these options in their own guidance. 
In such cases, a single preferred ArchiMate mapping may be selected for a given NAF IM 
element, with alternative mappings used only where explicitly justified by the architecture 
context. 

2.3.6 The definitions of the objects in the glossary are mainly derived from the NAF Information 
model. Where the objects are further specialized they are supplemented with explanations 
e.g. ArchiMate layer specific types of the definition. In other cases where an ArchiMate 
concept is used to represent an IM concept but the semantics don’t naturally align, then a 
case by case basis has been used to reflect an IM-centred definition or an ArchiMate only 
definition e.g. capability. 

2.4 Nodes in ArchiMate 

2.4.1 Before the publication of the NAFv4.1 Information Model, layered Nodes were used to 
represent the underlying business, application and technology performers. In the absence 
of a clearer metamodel, these Node specialisations were interpreted as resources at the 
logical level themselves, leading to modelling patterns such as Business Node, Application 
Node and Technology Node.  

2.4.2 The NAFv4.1 Information Model now clarifies that the Node is a generic, layer‑agnostic 
logical placeholder and performer, whereas the true layer‑specific semantics are provided 
by the Logical Active Resource (Node) subtypes (such as Logical Actor, Logical Application, 
Logical Technology and Logical Equipment). As a result, architects should use Node only 
when the nature of the performer is not yet known, and model the appropriate Logical Active 
Resource whenever the layer and type of resource can be identified. 
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3 HOW TO READ  

3.1 The Structure of each Viewpoint  

3.1.1 Each Viewpoint (cell in the NAFv4.1 grid) has the following subsections: 
• Viewpoint text 
• NAF IM Viewpoint  
• ArchiMate viewpoint 
• NAF IM ArchiMate Mapping table 
• Implementation Guidance 
• SAR ArchiMate Example 

3.2 ArchiMate Viewpoint Interpretation 

3.2.1 Elements on the viewpoints show the specialization name and are prefixed with a #, such as 
'# Logical Application' making their extended purpose immediately clear. They retain the 
standard ArchiMate notations and colours (acknowledging that there are no formal 
semantics around colours) to maintain familiarity and consistency for users.  This approach 
ensures that the specialized constructs remain intuitive while clearly conveying their 
specialized meaning within the NAFv4.1 framework. 

 
3.2.2 Bold borders on relationships and elements represent mandatory (shall be present in the 

viewpoint, otherwise objects are optional (may be present in the viewpoint). 

3.3 NAF IM ArchiMate Mapping Table 

3.3.1 Within the Implementation guidance section is included a table with 3 columns, this serves 
to provide a mapping between NAFv4.1, standard ArchiMate, and the specialized objects as 
part of this guide. In these tables the columns are: 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Name 

The name in the NAFv4.1 
Information Model.  

The name of the specialized 
ArchiMate element created for 
the purpose described in this 
document. 

The name of the generalized 
element from the ArchiMate 
specification from which the 
NAFv4 specialization is derived 

 

3.4 Implementation Guidance 

3.4.1 The guidance is intended to: 
• clarify mandatory modelling constraints and representation choices; 
• explain modelling choices that are implied by the NAF text but not stated explicitly; 
• help modellers apply the intended pattern consistently across related and more 

complex viewpoints. 
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3.4.2 Where terms refer to elements/relations in the NAF IM they will be bold. For those that are 
ArchiMate specific they are italicized. In some cases the use of italics is meant in the context 
of ArchiMate as opposed to a specific ArchiMate concept e.g. ‘services’ is shorthand for 
Business Services, Application Services, Technology Services. This applies to ‘interfaces’, 
‘functions’, processes’.  

3.4.3 The NAFv4.1 Information Model simplifies several viewpoints by displaying only the 
meta‑level superstructure element, for example showing Physical Active Resource. This 
approach is not compatible for the ArchiMate implementation. Accordingly, wherever the 
IM references a superstructure element, this guide includes all corresponding ArchiMate 
specialisations directly (where relevant) on the viewpoint to ensure completeness and 
remove ambiguity. The viewpoint diagram, the mapping table and the written guidance are 
intended to be read together, providing a full and unambiguous interpretation of each 
NAFv4.1 viewpoint.  

3.4.4 In a small number of cases, including every relationship on the diagram would make it 
unreadable; where this occurs, the implementation guidance explicitly notes relationships 
that exist in the metamodel but are omitted visually for clarity.  

3.4.5 To keep the text manageable, the implementation guidance places less emphasis on 
repeatedly distinguishing mandatory from optional, as this is already visible in the diagrams 
and stated in the IM.  

3.4.6 Each viewpoint’s guidance is written to stand alone and, where appropriate, 
cross‑references related viewpoints and sections to reinforce the intended modelling 
pattern.  

3.4.7 Note that element attributes and properties are not shown in the diagrams but are described 
in the guidance when relevant. 

3.5 Tool Requirements for Implementation 

3.5.1 This guide is written as tool agnostic, but the minimum requirement for any ArchiMate 
modelling tool is that it is capable of implementing the ArchiMate specializations required, 
as per the ArchiMate specification. The toolset must support the ability to either embed the 
specializations as attributes for tagging elements or visually represent them as stereotypes 
on objects. These features are critical for ensuring that the specialized framework is 
consistently applied and intuitive for users, enabling effective modelling, analysis, reporting 
and stakeholder communication. 
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4 ARCHIMATE SUPERSTRUCTURE MAPPING 

4.1 Mapping Purpose 

4.1.1 The following diagrams provide a visual mapping of the NAF IM Superstructure (NAFv4.1, 
Chapter 3, Section 3) to a subset of the specialized ArchiMate elements used in this guide. 
They show how the structural and behavioural aspects defined in the Information Model 
across the Logical and Physical rows are represented using the business, application, 
technology and physical layered specialisms. For clarity, the IM superstructure diagrams 
have been redrawn with the corresponding ArchiMate elements placed beneath each 
superstructure category. 

4.2 Logical and Physical Resource Mapping 

 
 
 

# Logical
Application

# Logical
Technology

Logical Actor

# Logical
Equipment# Role

Node

# Node # Actor

Logical Active Resource

Role Logical EquipmentLogical Technology

Technology Type

# System Software

Infrastructure Type

# Distribution
Network

Actual Equipment

# Equipment

Actual PostActual Organization

# Communication
Network

Organization Type Post Type

# Person

Actual Person

# Facility

Actual Infrastructure

Equipment Type

# Device

Physical Active
Resource

Actual Technology

# Post

Person Type

# Organization

is a kind of is a kind of

is a kind of

is a kind of

is a kind of

instantiates instantiates instantiates

is a kind of

instantiates instantiates

is a kind of is a kind of

instantiates

is a kind ofis a kind of

# Application
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4.3 Logical and Physical Behaviour Mapping 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Operational Activity

Logical Behavior

Logical Function

is a kind of is a kind of

Resource Function

Physical Behavior

is a kind of

# Operational
Activity

# Business
Function

# Application
Function

# Technology
Function

# Business
Process

# Application
Process

# Technology
Process
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4.4 Logical and Physical Passive Mapping 

Information ProductLogical Material

Logical Passive
Resource

Energy Concept Material Concept Information Product
Concept

Logical Energy

is a kind of

is a kind of

is a kind of

is a kind ofis a kind of

is a kind of

# Logical Energy # Logical Material # Information
Object

# Data Object# Material

# Artifact

Data Product Type

Actual Material

Material Type

Actual Data Product

# Energy

Physical Passive
Resource

Actual Energy

Energy Type

is a kind of

instantiates

is a kind ofis a kind of

instantiates instantiates
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5 C1 - CAPABILITY TAXONOMY 
 

Purpose Usage & Concerns Addressed 
The C1 Viewpoint is concerned with the 
identification of capabilities and their organization 
into specialization taxonomies, independent of 
their implementation. 

• Capability Planning and Management. 
• Identification of existing and required 
Capabilities. 
• Providing reference Capabilities for multiple 
architectures. 

 
Scope 
• Shall contain Capabilities relevant for the entity of interest 
• Shall contain Capabilities organized into specialization and hierarchical (aggregation) taxonomies. 
• May show Capabilities organized into Capability Groups. 
• May show Effectiveness Criteria for the Capabilities. 

 
Representation 
• Tabulation. 
• Hierarchical (Connected Shapes). 
• Diagram (with generalization relationships and property definitions). 

5.1 C1 NAF IM Viewpoint 

 

Capability

Effectiveness Criteria

Capability Groupdepends on

is a kind of

specifies

aggregates

aggregates
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5.2 C1 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Capability Group # Capability Group Grouping 
Effectiveness Criteria # Effectiveness Criteria Requirement 

 

5.3 C1 Implementation Guidance 

Hierarchical taxonomies of Capabilities are represented using the composition relation. Capability 
groupings are represented as groupings and they aggregate capabilities. Dependencies between 
Capability Groupings can be modelled with a serving relation. Specialization taxonomies of capabilities are 
represented using the specialization relationship. Effectiveness Criteria are represented as requirements 
that are realized by capabilities. 
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5.4 C1 ArchiMate Example 

 

«Capability»
High Sea

Maritime SAR

«Capability»
Maritime SAR

«Capability»
Near-Shore

Maritime SAR

«Capability»
High Mountains

SAR

«Capability»
Land SAR

«Capability»
SAR
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6 C2 - ENTERPRISE VISION 
 

Purpose Usage & Concerns Addressed 
The C2 Viewpoint is concerned with the scoping of 
the Architectural effort and providing the strategic 
context for the Capabilities described in the 
Architecture. 

• Enterprise Strategy. 
• Capability Planning. 
• Capture and communication of the strategic 
vision related to capability evolution. 
• Identify the capabilities required to meet the 
vision and goals. 
• Identify the required timescales for the 
capabilities as opposed to Cr which provides a 
summary of when projects are estimated to deliver 
capability. 
• Identify any enduring tasks the enterprise 
performs. 
• Provision of a blueprint for a transformational 
initiative. 

 
Scope 
• Shall contain the Enterprise Vision and the required Capabilities. 
• Shall contain Goals specified by the Vision. 
• Shall contain Enterprise Phases the Capabilities desire. 
• May show the Effects that the Capabilities desire. 
• May show Enduring Tasks linked to Capabilities and Goals. 

 
Representation 
• Structured Text.   
• Composite Structure Diagram. 

6.1 C2 NAF IM Viewpoint 

 

Enterprise VisionEffect

Enterprise Phase

Enduring Task

Capability

Goal

desires

supports

relates to

specifies

desires

requires

desiresdesires
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6.2 C2 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Effect # Outcome Outcome 
Enduring Task # Capability Capability 
Enterprise Phase # Enterprise Phase Plateau 
Enterprise Vision # Driver Driver 
Enterprise Vision # Goal Goal 
Goal # Goal Goal 
Goal # Outcome Outcome 

 

6.3 C2 Implementation Guidance 

The C2 Enterprise Vision expresses the strategic intent that drives capability evolution. In this viewpoint, 
several NAF IM concepts may play different roles depending on the modelling context; the mappings below 
explain the valid combinations. 
An Enterprise Vision can be either represented as a goal or driver, therefore a goal can specialize a goal, or 
be influenced by a driver. Capabilities influence drivers. 
Enduring Tasks can be represented as capabilities which influence a goal. 
Goals themselves are represented as either an outcome or a goal. This means Capabilities directly influence 
a goal or influence an outcome which realizes a goal. 
A plateau is used to represent an Enterprise Phase which aggregates the goal, outcome, capability and 
influences a driver. 
Outcomes are also further used to represent Effects that can be realized by capabilities. 

# Enterprise
Phase

# Capability

# Goal

# Driver# Outcome
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6.4 C2 ArchiMate Example 

 

«Capability»
Maritime SAR

«Enterprise
Phase»

Horizon 2030

«Goal»
Reduce Manpower

«Goal»
Increase Coverage

«Goal»
Improve Response

Times

«Driver»
Improved SAR

Safety &
Effectiveness
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7 C3 - CAPABILITY DEPENDENCIES 
 

Purpose Usage & Concerns Addressed 
The C3 Viewpoint is concerned with the 
identification of dependencies between 
capabilities. 

• Capability Management. 
• Analysis of dependencies between capabilities 
and between Capability groups. 
• Impact analysis for Capability options, disposal of 
Capabilities. 
• Highlight potential integration requirements and 
the interactions needed between acquisition 
projects in order to achieve the overall capability. 

 
Scope 
• Shall contain all dependencies between Capabilities relevant for the entity of interest.  
• May show the Capabilities Groups that the Capabilities belong to.  
• May show dependencies between Capability Groups.  
• May show Capability specializations. 

 
Representation 
• ‘Nested box’ diagram. 
• Class diagram. 
• Composite Structure diagram. 
 

7.1 C3 NAF IM Viewpoint 

 

7.2 C3 ArchiMate Viewpoint 

 
 

Capability Group Capability

is a kind of

depends on

aggregates

aggregates

depends on

# Capability# Capability
Group
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Capability Group # Capability Group Grouping 

 

7.3 C3 Implementation Guidance 

The serving relation is mandatory here to show dependencies between capabilities. Capability groupings 
are represented as groupings and they aggregate capabilities. Dependencies between Capability 
Groupings can be modelled with a serving relation. Capability Groups can also aggregate other Capability 
Groups. Specialization taxonomies of Capabilities are optionally represented using the specialization 
relationship. 

7.4 C3 ArchiMate Example 
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8 C4 - STANDARD PROCESSES 
 

Purpose Usage & Concerns Addressed 
The C4 Viewpoint is concerned with the 
identification of processes with the traceability to 
the Capabilities they support. 

• Doctrine Production. 
• Operational Analysis. 
• Specification of doctrine. 
• Tracing Capabilities to Standard Operational 
Activities. 
• Capability audit. 
• Concept of Operations. 

 
Scope 
• Shall contain Operational Activities relevant for the entity of interest. 
• Shall contain the capabilities that Operational Activities support. 
• May show Standard Operational Activities that support capabilities. 

 
Representation 
• Tabular. 
• Tracing Diagram. 

8.1 C4 NAF IM Viewpoint 

 

Standard Operational
Activity

Capability

supports

Operational Activity

is a kind of



 
 

26 NAFv4.1 ArchiMate 

8.2 C4 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Operational Activity # Operational Activity Business process 
Operational Activity # Value Stream Value stream 
Standard Operational Activity # Operational Activity Business process 

 

8.3 C4 Implementation Guidance 

The Operational Activity and the Standard Operational Activity are represented as a business process that 
realizes a capability. These Operational Activities may appear at different levels of abstraction; some 
define lower‑level tasks or activities, while others express strategic‑level intent. When an Operational 
Activity is expressed at this higher level, it may fit more naturally in the strategy layer, and can therefore be 
modelled as a value stream. Relationships from the business process realize the capability and serving 
relations exist between the capability and value stream to preserve traceability. 

8.4 C4 ArchiMate Example 

 

# Capability

# Operational
Activity

# Value Stream

«Capability»
Assistance

«Capability»
SAR C2

«Operational
Activity»

Monitor Health

«Operational
Activity»

Locate Patient
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9 C5 - EFFECTS 
 

Purpose Usage & Concerns Addressed 
The C5 Viewpoint is concerned with identifying and 
describing desired effects of Capabilities and the 
Effectiveness Criteria that are specified for them. 

• Operational Analysis. 
• Analysis of non-functional properties. 
• Characterization of the expected results 
capabilities, noting that effects can be positive or 
negative. 
• Analysis of cumulative effects. 
• Analysis of persistence of the effects. 
• Tracing the operational states and modes with 
regards to the effects. 

 
Scope 
• Shall contain Effects that the Capabilities desire. 
• May show Effectiveness Criteria that is specified by Capabilities. 
• May show Effectiveness Criteria characterizing the Effects. 
• May show measures that evaluate the Effectiveness Criteria. 

 
Representation 
• Tabular. 
• Structural diagram. 

9.1 C5 NAF IM Viewpoint 

 

Measure

EffectCapability

Effectiveness Criteria

desires

evaluates

is a kind of

specifies characterizes
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9.2 C5 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Effect # Outcome Outcome 
Effectiveness Criteria # Effectiveness Criteria Requirement 
Measure # Measure Business object 

 

9.3 C5 Implementation Guidance 

Outcomes are used to represent Effects that are realized by Capabilities. A requirement represents 
Effectiveness Criteria that can realize an outcome or be realized by a capability. Business objects represent 
Measures that can be associated with the Effectiveness Criteria. Rather than modelled as business objects, 
the Measures may be best captured as attributes on Effectiveness Criteria (requirement). 

# Capability

# Effectiveness
Criteria

# Measure

# Outcome
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9.4 C5 ArchiMate Example 

 

«Capability»
SAR

«Outcome»
Distressed person

rescued

«Outcome»
Distressed person

found

«Effectiveness Criteria»
Time to find

«Measure»
Time Bounds
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10 C7 - PERFORMANCE CRITERIA 
 

Purpose Usage & Concerns Addressed 
The C7 Viewpoint is concerned with the 
identification and description of measure 
categories (Assessment Criteria) and identification 
of capabilities to which they are applicable. 

• Capability Planning. 
• Capability Management. 
• Setting Capability Assessment Criteria. 
• Military Estimates. 
• Strategic Reviews. 
• Planning Assumptions. 

 
Scope 
• Shall contain the Capabilities characterized by the Assessment Criteria. 
• Shall contain Measures that evaluate Assessment Criteria. 
• May show Effectiveness Criteria specified by Capabilities. 
• May show Effectiveness Criteria that is evaluated by Measures. 

 
Representation 
• Tabular (capabilities on one axis, measure categories on the other). 
• Class diagram with property definitions. 

10.1 C7 NAF IM Viewpoint 

 

10.2 C7 ArchiMate Viewpoint 

 
 

Effectiveness Criteria

Assessment Criteria CapabilityMeasure
characterizes

evaluates

is a kind of

specifies

evaluates

# Capability

# Effectiveness
Criteria

# Assessment
Criteria# Measure
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Assessment Criteria # Assessment Criteria Requirement 
Capability # Capability Capability 
Effectiveness Criteria # Effectiveness Criteria Requirement 
Measure # Measure Business object 

 

10.3 C7 Implementation Guidance 

Business objects represent Measures that are associated with requirements. Requirements represent 
Assessment Criteria and Effectiveness Criteria. Capabilities realize Assessment Criteria and Effectiveness 
Criteria. Rather than modelled as business objects, the Measures may be best captured as attributes on 
Assessment Criteria and Effectiveness Criteria (requirements). 

10.4 C7 ArchiMate Example 

 

«Capability»
Maritime SAR

«Effectiveness
Criteria»

Time to find

«Assessment Criteria»
Coverage

«Assessment Criteria»
Weather Conditions

«Assessment Criteria»
Sea State

«Measure»
Coverage = 500

miles

«Measure»
Sea State = 3

«Measure»
Storm Force
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11 C8 - PLANNING CONSTRAINTS 
 

Purpose Usage & Concerns Addressed 
The C8 Viewpoint is concerned with the 
identification and description of assumptions 
(Strategic Constraints). 

• Capability Planning. 
• Planning Assumptions. 
• Implementation Planning. 

 
Scope 
• Shall contain Capabilities relevant for the entity of interest.  
• Shall contain Strategic Constraints that apply to the Capabilities.  
• May show Strategic Rationale relating to Strategic Constraints. 
• May show Effects the Capabilities desire.  
• May show the Vision that requires the Capability and the Goal it specifies. 

 
Representation 
• Tabular. 
• Benefits diagram. 
• Parametric diagram. 

11.1 C8 NAF IM Viewpoint 

 

Enterprise Vision

Effect

Capability

Strategic Rationale Goal

Strategic Constraint

requires

desires

applies to

originates from specifies
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11.2 C8 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Effect # Outcome Outcome 
Enterprise Vision # Driver Driver 
Enterprise Vision # Goal Goal 
Goal # Goal Goal 
Goal # Outcome Outcome 
Strategic Constraint # Constraint Requirement 
Strategic Rationale # Rationale Driver 

 

11.3 C8 Implementation Guidance 

Drivers are specialized to represent Rationale at the Strategic, Logical and Resource Subject of Concerns 
(rows). Requirements are specialized to represent Constraints at the Strategic, Service, Logical and 
Resource Subject of Concerns (rows). The specialized drivers (Rationale) influence the requirement 
(Constraint). These requirements are associated with Capabilities. 
In this viewpoint, several NAF IM concepts may play different roles depending on the modelling context; 
the mappings below explain the valid combinations. 
An Enterprise Vision can be either represented as a goal or driver, therefore a goal can specialize a goal, or 
be influenced by a driver. Capabilities influence drivers. 
Goals themselves are represented as either an outcome or a goal. This means Capabilities directly influence 
a goal or influence an outcome which realizes a goal. 
Outcomes are also further used to represent Effects that can be realized by Capabilities. 

# Constraint

# Rationale

# Goal

# Capability # Driver

# Outcome
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11.4 C8 ArchiMate Example 

 

«Capability»
Maritime SAR

«Constraint»
C2 Unit must be permanently

available

«Constraint»
Search covers radius of 10km

in 3 simultaneous missions
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12 CR - CAPABILITY ROADMAP 
 

Purpose Usage & Concerns Addressed 
The Cr Viewpoint is concerned with identifying 
Capability Milestones related to Capability 
Increments and the Capabilities it delivers. 

• Capability Planning. 
• Acquisition Management. 
• Capability phasing. 
• Capability integration planning. 
• Capability gap/surplus analysis. 
• High-level dashboard for acquisition 
management. 

 
Scope 
• Shall contain Capability Milestones. 
• Shall contain the Capability Increments that the Capability Milestone defines. 
• Shall contain the Capabilities the Capability Increments delivers. 
• May show Enterprise Phases related to Capability Increments. 
• May show the ordering and grouping of Enterprise Phases. 
• May show Capability Projects and how they schedule Capability Milestones during the evolution of the 
Capability. 
• May trace Capability Configurations to Capabilities. 

 
Representation 
• A time based chart in the style of a Gantt chart. 

12.1 Cr NAF IM Viewpoint 

 
Capability Milestone

Enterprise Phase

Capability Increment

Capability

defines

deliversrelates to

Capability Project
schedules

defines evolution of

triggers aggregates

Capability Configuration
realizes
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12.2 Cr ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Capability Configuration # Capability Configuration Grouping 
Capability Increment # Capability Capability 
Capability Milestone # Milestone Implementation event 
Capability Project # Work Package Work package 
Enterprise Phase # Enterprise Phase Plateau 

 

12.3 Cr Implementation Guidance 

Capability Increments and Capabilities are represented as capabilities with a composition relation between 
capabilities to model the increments. Work packages represent Projects and Programs that deliver 
Capability Increments, therefore a work package can realise a capability. Milestones can be modelled as 
implementation events with associations between the capability and the work package or as an attribute of 
the work package/capability. Groupings represent Capability Configurations that realise a capability. 
Plateaus are used to represent Enterprise Phases.  They can aggregate and trigger other Enterprise Phases 
and aggregate capabilities. 

# Capability# Enterprise
Phase

# Milestone # Work Package

# Capability
Configuration
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12.4 Cr ArchiMate Example 

 

«Capability»
Maritime SAR

«Capability»
Maritime Rescue

by Aircraft

«Enterprise
Phase»

Horizon 2030

«Enterprise
Phase»

IOC

«Enterprise
Phase»
MOC

«Enterprise
Phase»

FOC
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13 S1 - SERVICE TAXONOMY 
 

Purpose Usage & Concerns Addressed 
The S1 Viewpoint is concerned with the 
identification of service specifications, and their 
organization into specialization taxonomies. 

• Service planning. 
• Service audit. 
• Identification of services. 
• Defining measures for Service Levels. 
• Service gap analysis. 
• Providing reference services for architectures. 
• Tailoring generic services for specific 
applications. 

 
Scope 
• Shall contain all Services organized into specialization taxonomies relevant for the entity of interest. 
• May show Services organized into Service Groups, and their groupings. 
• May show how Services satisfy Service Policies. 

 
Representation 
• Tabulation. 
• Hierarchical (connected shapes). 
• Class diagram. 

13.1 S1 NAF IM Viewpoint 

 

Service Group

Service Service Policy
satisfies

aggregates

aggregates

is a kind of
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13.2 S1 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Group # Service Group Product 
Service Policy # Service Policy Requirement 

 

13.3 S1 Implementation Guide 

Services exist at three layers within ArchiMate: business, application and technology. Where the layering of 
services is applicable to the architecture, they must be present on the viewpoint. 
Specialization taxonomies of Services are represented using the specialization relation. 
Service Policies are represented as requirements and are realized by a business, application or technology 
services. These services can be aggregated into a business product to represent a Service Group. Service 
Groups can aggregate other Service Groups. 

# Application
Service

# Business
Service

# Technology
Service

# Service Group

# Service Policy
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13.4 S1 ArchiMate Example 

 

«Business Service»
Underwater Rescue Service

«Business Service»
Offshore Rescure Service

«Business Service»
Inshore Rescue Service

«Business Service»
Maritime Rescue Service

«Service Policy»
In Mission
Operation
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14 S2 - SERVICE STRUCTURE 
 

Purpose Usage & Concerns Addressed 
The S2 Viewpoint is concerned with the 
identification of how Services are structured and 
their dependencies to other services. 

• Service planning 
• Service composition. 
• Service dependency analysis. 
• Service interoperability. 

 
Scope 
• Shall contain Services relevant for the entity of interest and their structural organization. 
• Shall contain dependencies between these Services. 
• May show Service Interfaces that the Service specifies. 
• May show Service Functions that the Service enables. 
• May show Service Consumers or Service Providers that consume/provide the Service. 
• May trace Services to Physical Active Resources. 
• May trace Services to Nodes that deliver or consume the Service and how these relate to a Service 
Provide or Service Consumer.  

 
Representation 
• Tabular. 
• Matrix. 
• Dependency graph. 
• Diagram. 

 

14.1 S2 NAF IM Viewpoint 

 

Service

Service Interface

Service Consumer

Service Function

Physical Active
Resource

Node

Service Provider

relies on

delivers

specifies

realizes

consumes

relies on

enables

depends on aggregates

provides

consumes
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14.2 S2 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Node # Node Grouping 
Node # Role Business role 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Consumer # Node Grouping 
Service Consumer # Role Business role 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 
Service Interface # Application Interface Application interface 
Service Interface # Business Interface Business interface 
Service Interface # Technology Interface Technology interface 
Service Provider # Node Grouping 
Service Provider # Role Business role 
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14.3 S2 Implementation Guidance 

Services exist at three layers within ArchiMate: business, application and technology. Where the layering of 
services is applicable to the architecture, they must be present on the viewpoint. 
Structural hierarchies of services are modelled with the composition relation and dependencies are 
modelled with the serving relation. Service dependencies are cross‑layer; any service layer may serve 
services in other layers. 
Service Interfaces exist at three layers within ArchiMate: business, application and technology. The layer 
specific interface is assigned to the corresponding service. Service Functions exist at three layers within 
ArchiMate: business, application and technology, the layer specific function serves the corresponding 
service. 
Service Providers and Service Consumers are either Nodes or Roles in the context of the scenario you are 
modelling. The Node is represented as a grouping and the Role as a business role. The Node may be 
assigned to the Role. The Node may realize (deliver) a service or be served by (consume) a service. The Role 
may be assigned to or associated with (provide) a service depending on its layer. The Role may also be 
served by (consume) a service. 
The Physical Active Resource can be represented as a number of ArchiMate elements, the full breakdown 
is shown in Section 4.2. Where relevant, the mapped ArchiMate elements can realize their corresponding 
layered service. 
Given that the Node breaks down into further sub-types as shown in Section 4.2, instead of the Node, other 
ArchiMate Logical Active Resource mappings may be used, as shown in this viewpoint example. 

14.4 S2 ArchiMate Example 

 

«Business Service»
Situation Information

Consolidation

«Business Service»
Position Determination

Service

«Business Service»
Document Management

Service

«Business Interface»
Get Area

«Business Function»
Get Area of Interest

«Logical Application»
Air Traffic Control

System

«Technology Service»
Platform Service

«Technology Service»
Storage Service

«Node»
SAR Asset Controller
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15 S3 - SERVICE INTERFACES 
 

Purpose Usage & Concerns Addressed 
The S3 Viewpoint is concerned with the 
identification and specification of Service 
Interfaces. 

• Service implementation guidance. 
• Service interoperability. 
• Service integration. 
• Defining Service interfaces and their boundaries. 

 
Scope 
• Shall contains Service Interfaces specified by a Service. 
• May show Service Operations for Service Interfaces. 
• May show Service Operation Parameters for Service Operations. 
• May trace Service Operation Parameters to Physical Passive Resources. 

 
Representation 
•Tabular. 
• Diagram. 

15.1 S3 NAF IM Viewpoint 

 

Service

Service Operation

Service Operation
Parameter

Service Interface

has

specifies

specifies

Physical Passive
Resource

involves
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15.2 S3 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Interface # Application Interface Application interface 
Service Interface # Business Interface Business interface 
Service Interface # Technology Interface Technology interface 
Service Operation # Application Operation Application function 
Service Operation # Business Operation Business function 
Service Operation # Technology Operation Technology function 
Service Operation Parameter # Artifact Artifact 
Service Operation Parameter # Service Operation Parameter Business object 

 
 

# Business
Interface

# Application
Service

# Business
Service

# Application
Interface

# Technology
Service

# Technology
Interface

# Business
Operation

# Service
Operation
Parameter

# Application
Operation

# Technology
Operation

# Material # Energy# Data Object # Artifact
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15.3 S3 Implementation Guide 

Services and Service Interfaces exist at three layers within ArchiMate: business, application and technology. 
Where this layering is applicable to the architecture, they must be present in this viewpoint. Each service 
must be assigned to an interface. 
Service Operations, represented as functions, exist at three layers within ArchiMate: business, application 
and technology. They can serve the interfaces. Service Operation Parameters are represented as business 
objects which are accessed by the Service Operations and are associated with the mapped Physical Passive 
Resources as shown in Section 4.4.  
Alternatively each operation can access the Physical Passive Resources directly, and the Service Operation 
Parameter can be associated with the access relation. This is not shown on the viewpoint. 

15.4 S3 ArchiMate Example 

 

«Business Interface»
Situation Picture

«Business Service»
Situation Information

Consolidation

«Business Operation»
Set Area of Interest

«Business Operation»
Submit Location of

Resource

«Service Operation Parameter»
Track

«Service Operation Parameter»
Resource

«Service Operation Parameter»
Geographic Location

«Data Object»
Target Track

Report

«Data Object»
Position Report
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16 S4 - SERVICE FUNCTIONS 
 

Purpose Usage & Concerns Addressed 
The S4 Viewpoint is concerned with the definition 
of the behaviour of a Service in terms of the 
Functions and Operational Activities that enable it. 

• Better understanding of the level of detail 
required by a Service. 
• Outline requirements for Service behaviour. 
• Service implementation guidance. 
• Service specification & planning. 

 
Scope 
• Shall contain all Service Functions that enable a Service. 
• May show groupings of Service Functions. 
• May show Service Providers and/or Service Consumers relating to the Service Function or Service. 
• May show Operational Activities that support or are enabled by Service Functions. 
• May show Operational Activities that need to be performed by a Service Provider or Service Consumer. 

 
Representation 
•Tabular. 
• Diagram. 

16.1 S4 NAF IM Viewpoint 

 

Service

Operational Activity

Service Function

supports enables

enables

Service Provider
notifies

performs

provides

Service Consumer

consumes

performs

accesses

aggregates
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16.2 S4 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Operational Activity # Operational Activity Business process 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Consumer # Actor Business actor 
Service Consumer # Logical Application Application component 
Service Consumer # Logical Equipment Equipment 
Service Consumer # Logical Technology Node 
Service Consumer # Node Grouping 
Service Consumer # Role Business role 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 
Service Provider # Actor Business actor 
Service Provider # Logical Application Application component 
Service Provider # Logical Equipment Equipment 
Service Provider # Logical Technology Node 
Service Provider # Node Grouping 
Service Provider # Role Business role 

 

# Business
Service

# Business
Function

# Application
Service

# Technology
Service

# Application
Function

# Technology
Function

# Operational
Activity

# Role

# Actor # Logical
Application

# Logical
Equipment

# Logical
Technology

# Node
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16.3 S4 Implementation Guidance 

Services exist at three layers within ArchiMate: business, application and technology. Service Functions 
exist at three layers within ArchiMate: business, application and technology. The layer specific function 
serves the corresponding service. Where the layering of services and functions is applicable to the 
architecture, they must be present on the viewpoint. Functions can aggregate functions of the same type. 
Functions serve (enable) the service. 
Business processes represent Operational Activities. These can serve (support) the function or be served by 
(enables) the function. 
Service Providers and Service Consumers in this viewpoint are all subtypes of Logical Active Resource 
(including Nodes and/or Roles) depending on the context of the scenario you are modelling the and level of 
detail known. The Node is represented as a grouping and the Role as a business role. Services can serve the 
Node or Role. 
The subtypes of Logical Active Resource are detailed in Section 4.2. The mapped Logical Active Resources 
can realize (provide) a service or be served by (consume) a service. Depending on the layer of the mapped 
Logical Active Resources, they can be assigned to or associated with (perform) the business process. 

16.4 S4 ArchiMate Example 

 

«Business Function»
Data Receiving

«Business Service»
Situation Information

Consolidation

«Application Function»
Notifying of Success

«Application Function»
Persisting

«Application Function»
Data Storing
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17 S5 - SERVICE STATES 
 

Purpose Usage & Concerns Addressed 
The S5 Viewpoint is concerned with the 
identification and definition of the possible states a 
Service may have, and the possible transitions 
between those states. 

• Better understanding of the level of detail 
required by a Service. 
• Outline requirements for Service behaviour. 
• Service implementation guidance. 
• Service behaviour specification. 

 
Scope 
• Shall contain all Service States of a Service relevant for the entity of interest. 
• Shall contain Service State Transitions between Service States. 
• May show Service Events triggering Service State Transitions. 
• May show Service Functions that are enabled by a Service State. 
• May show Service Functions that enable the Service. 
• May show Service Modes of a Service Function. 
• May show Service States grouped into Service State Groups, and their groupings. 

 
Representation 
• Diagram. 
• State transition model. 

17.1 S6 NAF IM Viewpoint 

 

Service Service State GroupService State

Service Function

Service Mode

Service Event

Service State Transition
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aggregates
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aggregates

enables

Service State Transition

is equal to
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17.2 S5 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Event # Logical Event Business event 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 
Service Mode # Mode Business event 
Service State # Application State Application event 
Service State # Business State Business event 
Service State # Technology State Technology event 
Service State Group # Application State Application event 
Service State Group # Business State Business event 
Service State Group # Technology State Technology event 
Service State Transition # State Transition Business interaction 

 
 
 
 
 
 
 
 
 

# Business State# Business
Service

# Application
State

# Technology
State

# Application
Service

# Technology
Service

# Business
Function

# Application
Function

# Technology
Function

# Logical Event
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17.3 S5 Implementation Guidance 

Services and Service States exist at three layers within ArchiMate: business, application and technology. 
Service States are represented by the layer appropriate ArchiMate event. Service State Groups are 
represented as aggregation relations between the states. Services are associated with (has) corresponding 
layer states. Service States trigger other Service States. States trigger other states at each ArchiMate layer; 
this is not shown in the viewpoint. 
Service State Transitions are represented as business interactions. They are the objectification of the 
trigger relation between Service States. The option of using business interactions or triggering relations 
depends on the tooling constraints and level of detail required for modelling the scenario. A business event 
represents a Service Event and can trigger this transition. Note that the specialism of business event # 
Logical Event is used. 
Service Functions exist at three layers within ArchiMate: business, application and technology. The layer 
specific function serves the corresponding service layer and is served by the corresponding state layer. 
Service Modes are represented as business events and can be associated with a function. 

17.4 S5 ArchiMate Example 

 

«Business Service»
Position Determination

Service

«Business State»
Out of Service

«Business State»
Service is Provided

«Logical Event»
Denial of Service

«State Transition»
In Service to Out of

Service
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18 S6 - SERVICE  SEQUENCE 
 

Purpose Usage & Concerns Addressed 
The S6 Viewpoint is concerned with identifying the 
chronological sequence of interactions between 
services in a scenario. 

• Outline requirements for Service behavior. 
• Service implementation guidance. 
• Service Orchestration. 

 
Scope 
• Shall contain Service Lifelines representing Services. 
• Shall contain the Service Interactions between Service Lifelines. 
• May show Service Events that trigger Service Interactions. 
• May show Service Functions that enable the Service. 
• May show Service Interfaces specified by the Service. 
• May show Service Operations specified by the Service Interface or relating to the Service Interaction. 

 
Representation 
• Sequence Diagram. 

18.1 S6 NAF IM Viewpoint 

 

Service Lifeline

Service

Service Interaction

Service Event

Service Function

represents a timeline of

triggers
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Service Interaction

Service Interface
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Service Operation
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is equal to
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18.2 S6 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Event # Logical Event Business event 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 
Service Interaction # Interaction Business interaction 
Service Interface # Application Interface Application interface 
Service Interface # Business Interface Business interface 
Service Interface # Technology Interface Technology interface 
Service Lifeline # Logical Lifeline Business process 
Service Operation # Application Operation Application function 
Service Operation # Business Operation Business function 
Service Operation # Technology Operation Technology function 

 
 
 
 

# Application
Service

# Business
Service

# Technology
Service

# Interaction

# Business
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18.3 S6 Implementation Guidance 

Services exist at three layers within ArchiMate: business, application and technology. Service Lifelines are 
represented as business processes with the specialism # Logical Lifeline. Service Interactions are 
represented as business interactions with the specialism # Interaction. They are the objectification of the 
trigger relation between Service Lifelines. The option of using interactions or triggering relations depends 
on the tooling constraints and level of detail required for modelling the scenario. A business event 
represents a Service Event and can trigger the # Interaction. 
Service Functions exist at three layers within ArchiMate: business, application and technology, the layer 
specific function serves the corresponding service. 
Service Interfaces exist at three layers within ArchiMate: business, application and technology. They can be 
assigned to the corresponding service layer.  
Service Operations, represented as functions, exist at three layers within ArchiMate: business, application 
and technology. They can serve the corresponding interface layer and be associated with the # Interaction. 

18.4 S6 ArchiMate Example 

 

«Business Service»
Situation Information

Consolidation

«Business Interface»
Coordination Interface

«Business Interface»
Rescue Interface

«Business Service»
Search and Rescue

Service

«Business Operation»
S2 Operation

«Business Operation»
S3 Operation

«Logical Lifeline»
Coordination Service

Lifeline

«Logical Lifeline»
SAR Service Lifeline

«Interaction»
Request Sortie

«Interaction»
Acknowledge



 
 

56 NAFv4.1 ArchiMate 

19 S7 - SERVICE INTERFACE PARAMETERS 
 

Purpose Usage & Concerns Addressed 
The S7 Viewpoint is concerned with the 
identification and specification of all the 
parameters used in service operations/ functions 
for the interface in scope. 

• Detailed Service design. 
• Service compatibility analysis. 
• Service-oriented architecture governance. 
• Service interoperability. 

 
Scope 
• Shall contain parameters of Service Operations or parameters of Service Functions relevant for the 
entity of interest. 
• Shall contain Passive Resources involved in Services Functions or Service Operation Parameters. 
• May show Services that are enabled by the Service Functions. 
• May show Service Interfaces that specify the Service Operation, and the Services that specify the 
Service Interface. 

 
Representation 
• Tabular. 
• Diagram. 

19.1 S7 NAF IM Viewpoint 
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19.2 S7 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Passive Resource # Information Object Business object 
Physical Passive Resource # Data Object Data object 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 
Service Function Parameter # Service Function Parameter Business object 
Service Interface # Application Interface Application interface 
Service Interface # Business Interface Business interface 
Service Interface # Technology Interface Technology interface 
Service Operation # Application Operation Application function 
Service Operation # Business Operation Business function 
Service Operation # Technology Operation Technology function 
Service Operation Parameter # Service Operation Parameter Business object 

 

19.3 S7 Implementation Guidance 

Service Operations and Service Functions, represented as functions, exist at three layers within ArchiMate: 
business, application and technology. 
Services and Service Interfaces exist at three layers within ArchiMate: business, application and technology. 
Service Functions can serve Services, whilst Service Operations can serve Service Interfaces.  
Each Service may be assigned to a Service Interface. 
Service Operation Parameters and Service Function Parameters, both represented as business objects are 
accessed by the Service Operation and Service Function respectively.  
Service Operation Parameters can be associated with # Information Objects (represented as business 
objects) which is the relevant Logical Passive Resource in the context of this viewpoint. Service Function 
Parameters can be associated with # Data Objects (represented as data objects) which is the relevant 
Physical Passive Resource in the context of this viewpoint. 

# Business
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# Application
Interface

# Technology
Service

# Business
Service
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Service
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# Business
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19.4 S7 ArchiMate Example 

 

«Business Service»
Situation Information

Consolidation

«Business
Function»

Data Receiving

«Business Interface»
Situation Picture

«Business Operation»
Set Area of Interest

«Business Operation»
Submit Location of

Resource

«Service Operation Parameter»
Geographic Location

«Service Operation Parameter»
Resource

«Service Operation Parameter»
Track

«Service Function Parameter»
Incoming Data

«Service Function Parameter»
Data Payload

«Data Object»
Target Track Report

«Data Object»
Position Report

«Application
Function»

Data Storing

«Information Object»
Situational Report

«Information Object»
Consolidated Situational

Report
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20 S8 - SERVICE  CONSTRAINTS 
 

Purpose Usage & Concerns Addressed 
The S8 Viewpoint is concerned with the 
identification and description of rules and 
constraints that apply to Service implementations, 
their operation and their use. 

• Service design. 
• Contracting for Services. 
• User / System Requirements.. 
• Service governance. 

 
Scope 
• Shall contain Service Constraints that are grouped by Service Policies. 
• May show Services that satisfy the Service Policy. 
• May shows Measures the Service Constraints can be evaluated by. 

 
Representation 
• Tabular. 
• Diagram. 
• Text Document. 
• Parametric diagram. 

20.1 S8 NAF Viewpoint 

 

Service

Service Policy Service Constraint

Measure

satisfies evaluates

aggregates
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20.2 S8 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Measure # Measure Business object 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Constraint # Constraint Requirement 
Service Policy # Service Policy Requirement 

 

20.3 S8 Implementation Guidance 

Service Policies are represented as requirements. Requirements are also used to represent Constraints, and 
they can be aggregated by the Service Policy. 
Services exist at three layers within ArchiMate: business, application and technology and each can realize 
the Service Policy.  
Measures are represented as business objects that can be associated with Constraints. 

# Business
Service

# Application
Service

# Technology
Service

# Measure

# Constraint# Service Policy
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20.4 S8 ArchiMate Example 

 

«Business Service»
Inshore Rescue

Service

«Constraint»
Availability

24x7x52

«Constraint»
Compliant with

MC 326/3

«Service Policy»
In Mission
Operation
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21 SR - SERVICE ROADMAP 
 

Purpose Usage & Concerns Addressed 
The Sr Viewpoint is concerned with Service 
Roadmaps with Service Milestones related to the 
evolution of Service. 

• Service Life Cycle Planning. 
• Acquisition Management. 
• Service phasing. 
• Service gap/surplus analysis. 
• Service orientated architecture governance. 

 
Scope 
• Shall contain Service Milestones that define the Service Readiness Levels. 
• Shall contain the Services that fulfil the Service Readiness Level. 
• May show Service Projects and how they schedule Service Milestones and define the evolution of the 
Service. 

 
Representation 
• A time based chart in the style of a Gantt chart. 
• Tabular. 
• High-level dashboard. 

21.1 Sr NAF IM Viewpoint 

 

Service Readiness
LevelService

Service Milestone
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Service Project
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21.2 Sr ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 
Service Milestone # Milestone Implementation event 
Service Project # Work Package Work package 
Service Readiness  Level # Readiness Level Plateau 

 

21.3 Sr Implementation Guidance 

Services exist at three layers within ArchiMate: business, application and technology and Service 
Milestones are represented as implementation events. Service Readiness Levels are represented as 
plateaus that aggregate the services and are associated with the implementation event. Service Projects 
are represented as work packages. Service Milestones are associated with the # Readiness Level. 
Alternatively, they may be captured as attributes on the # Readiness Level and so to represent the 
schedules relation, work packages can realize the # Readiness Level and be associated with the Service 
Milestone. Work packages can realize each of the services. 

# Business
Service

# Application
Service

# Technology
Service

# Work Package

# Milestone

# Readiness Level
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21.4 Sr ArchiMate Example 

 

«Milestone»
IOC 2035

«Milestone»
MOC 2040

«Milestone»
FOC 2045

«Readiness Level»
SIC 1

«Readiness Level»
SIC 2

«Readiness Level»
SIC 3

«Business Service»
Situation Information

Consolidation
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22 C1-S1 SERVICE TO CAPABILITY MAPPING 
 

Purpose Usage & Concerns Addressed 
The C1-S1 Viewpoint is concerned with 
identification and description of services that 
enable capabilities.  

• Mapping of capabilities to services that they are 
supported by. 
• Service Specification & Planning. 
• Governance. 

 
Scope 
• Shall denote Services relevant for the architecture. 
• Shall denote Capabilities relevant for the architecture. 
• Shall link Services to Capabilities they enable or they contribute to. 

 
Representation 
• Matrix (with capabilities on one axis, and services on the other one). 
• Diagram. 

22.1 C1-S1 NAF IM Viewpoint 

 

Capability

Service

aims to achieve
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22.2 C1-S1 ArchiMate Viewpoint  

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 

 

22.3 C1-S1 Implementation Guidance 

Services exist at three layers within ArchiMate: business, application and technology. Where the layering of 
services is applicable to the architecture, they must be present on the viewpoint. Each of the services 
realize a Capability. 

22.4 C1-S1 ArchiMate Example 

 

# Business
Service

# Capability

# Technology
Service

# Application
Service

«Capability»
Maritime SAR

«Business Service»
Rescue Service

«Capability»
Situational
Awareness

«Capability»
Recovery

«Business Service»
Maritime Recovery Service

«Business Service»
Situational Service
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23 L1 - LOGICAL TAXONOMY 
 

Purpose Usage & Concerns Addressed 
The L1 Viewpoint is concerned with the 
identification of Nodes, and their Active Resource 
(Logical) and Logical behaviour, and their 
organization into specialization taxonomies 

• Operational Planning. 
• High-Level Requirements. 
• Initial set up of a Logical Architecture. 
• Defining the types of environment in which 
Nodes may operate. 

 
Scope 
• Shall contain all Nodes relevant for the entity of interest organized into specialization taxonomies. 
• Shall contain Logical Active Resources and Logical Behaviour that are relevant for the entity of interest, 
grouped by Nodes and organized into specialization taxonomies. 
• May show Passive Resources (Logical) that are relevant for the entity of interest, grouped by Nodes. 
• May trace Nodes to Capabilities they need or support. 

 
Representation 
• Topological (connected shapes). 
• Tabular. 

23.1 L1 NAF IM Viewpoint 

 

Logical Active Resource
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Capability
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aggregates
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23.2 L1 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Active Resource # Node Grouping 
Logical Behaviour # Application Function Application function 
Logical Behaviour # Business Function Business function 
Logical Behaviour # Operational Activity Business process 
Logical Behaviour # Technology Function Technology function 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Node # Actor Business actor 
Node # Logical Application Application component 
Node # Logical Equipment Equipment 
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Node # Logical Technology Node 
Node # Node Grouping 

23.3 L1 Implementation Guidance 

Nodes are represented as groupings. They aggregate the mapped Logical Active Resources (including the 
Node subtypes), Logical Behaviour and Logical Passive Resources detailed in Section 4. They can realize 
and be served by capabilities. The Node specializes other Nodes and the mapped ArchiMate Logical Entities 
specialize other mapped ArchiMate Logical Entities. The Node aggregates other Nodes and mapped 
ArchiMate Logical Entities. 

23.4 L1 ArchiMate Example 

 

«Capability»
SAR

«Logical Equipment»
Communication

Device

«Logical Application»
Surveillance System

«Logical Equipment»
Onshore Rescue

Vessel

«Actor»
Crew

«Information Object»
Information Model

«Node»
Search

«Node»
Search and Rescue

«Node»
Space Rescue

«Node»
Airborne Rescue

«Node»
Rescue

«Node»
Waterborne

Rescue
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24 L2 - LOGICAL STRUCTURE 
 

Purpose Usage & Concerns Addressed 
The L2 Viewpoint is concerned with identifying of 
how nodes are structured and their dependencies 
to other nodes through the use of Needlines for a 
relevant logical scenario. 

• User Requirements. 
• Operational Planning. 
• Scenario Specification. 
• Definition of operational concepts. 
• Definition of collaboration needs. 
• Problem space definition. 
• Supply chain analysis. 

 
Scope 
• Shall contain Nodes relevant for the entity of interest and their structural organization. 
• Shall contain Needlines between Nodes. 
• May show Logical Passive Resources that the Needlines convey. 

 
Representation 
• Topological (connected shapes). 
• Composite structure diagram. 
• Rich Picture. 

24.1 L2 NAF IM Viewpoint 
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aggregates
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24.2 L2 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Needline # Needline Business collaboration 
Node # Node Grouping 

 

24.3 L2 Implementation Guidance 

Nodes are represented as groupings and aggregate other Nodes. The Needline can be modelled as either a 
flow relation between the # Node or with a business collaboration that is associated with the flow relation. 
The option of using business collaborations or flow relations depends on the tooling constraints and level of 
detail required for modelling the scenario. 
The # Needline can then access the relevant mapped Logical Passive Resources detailed in Section 4.4. 

# Logical Energy# Logical Material

# Needline

# Information
Object

# Node
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24.4 L2 ArchiMate Example 

 

«Node»
SAR Asset
Controller

«Node»
Search

«Node»
Rescue

control

tasking
status

«Node»
Tactical C2

control

rescue

tasking
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25 L2-L3 -  LOGICAL CONCEPT 
 

Scope 
The L2-L3 is presented as a rich picture in most cases. Therefore, no information model elements are 
shown here. However, an L2-L3 may be constructed with a Node and it's Needlines. 

 

25.1 L2-L3 NAF IM Viewpoint 

 

25.2 L2-L3 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Node # Node Grouping 

 

25.3 L2-L3 Implementation Guidance 

Nodes are represented as groupings and Needlines represented as flows between them. 

Node

Needline

# Node
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26 L3 - LOGICAL INTERACTIONS 
 

Purpose Usage & Concerns Addressed 
The L3 Viewpoint is concerned with identifying all 
relevant interactions between Nodes. 

• Interoperability requirements. 

 
Scope 
• Shall contain Logical Interactions between Logical Active Resources relevant to the entity of interest. 
• Shall contain the Logical Passive Resources being conveyed by the Logical Interaction. 
• May show Logical Interactions to the Needline. 
• May show the Nodes relating to the Needlines and the Logical Active Resources they aggregate. 
• May show the Logical Passive Resources asked for by the Needline. 
• May show the Logical Interaction to Logical Passive Resources. 

 
Representation 
• Tabulation. 
• Information flow diagram. 
• Sankey diagram. 
 

26.1 L3 NAF IM Viewpoint 
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26.2 L3 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Active Resource # Node Grouping 
Logical Interaction # Interaction Business interaction 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Needline # Needline Business collaboration 
Node # Actor Business actor 
Node # Logical Application Application component 
Node # Logical Equipment Equipment 
Node # Logical Technology Node 
Node # Node Grouping 

 
 
 

# Logical Energy# Logical Material

# Needline

# Interaction

# Logical
Equipment

# Logical
Application# Actor # Logical
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Object

# Node
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26.3 L3 Implementation Guidance 

In the context of this viewpoint, the Logical Active Resources are the mapped Node subtypes detailed in 
Section 4.2. Logical Interactions are represented as either flow relations between all the relevant mapped 
Logical Active Resources or as business interactions (specialized as # Interaction) that are associated with 
the flow relations.  
Nodes are represented as groupings with Needlines represented as the same pattern elaborated in the L2 
Implementation Guidance. The # Node can aggregate the mapped Logical Active Resources.  
The # Interaction can be associated with the # Needline. The # Needline and the # Interaction can access 
the mapped Logical Passive Resources detailed in Section 4.4. If the Logical Interaction is modelled with 
flow relations, then it is also possible to have the passive elements be associated with the flow relation as 
shown in the example. 

26.4 L3 ArchiMate Example 

 

«Information Object»
Approach Information

«Information Object»
Field Medical Card

«Information Object»
Informal Situation Report

«Information Object»
Informal Situation Report

«Information Object»
Informal Situation Report

«Information Object»
Strategic MEDEVAC

Tasking

«Information Object»
Informal Patient Situation

Report

«Information Object»
Informal Patient Situation

Report

«Information Object»
Pre-warning

«Information Object»
9-Liner

«Information Object»
9-Liner

«Actor»
MEDEVAC Element

Military Formation

«Actor»
MEDEVAC Element

Military Formation

«Actor»
Casualy Affected Unit

«Actor»
Casualy Affected Unit

«Actor»
Casualy Affected Unit

«Actor»
Casualy Affected Unit

«Actor»
Casualy Affected Unit

«Actor»
Transportation Unit

«Actor»
Transportation Unit

«Actor»
Transportation Unit

«Actor»
MEDEVAC Element

Major Military
Formation

«Actor»
MEDEVAC Element

Major Military
Formation
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27 L4 - LOGICAL ACTIVITIES 
 

Purpose Usage & Concerns Addressed 
The L4 Viewpoint is concerned with the 
identification of Logical Activities, grouping and 
composition of these Activities and logical flows 
between the Activities. 

• Description of business processes and workflows. 
• Operational Planning. 
• Concept of Operations. 
• Service Orchestration. 
• Requirements capture, derivation and 
traceability 
• Logistics support analysis. 
• Information flow analysis. 
• Support task analysis to determine training 
needs. 
• Mission Threads. 

 
Scope 
• Shall contain Operational Control Flows between Operational Activities. 
• Shall contain Nodes (or Roles that they hold) that perform Operational Activities. 
• May show Logical Events that trigger and can be triggered by Operational Activities. 
• May show Operational Flows between Operational Activities. 
• May show Logical Passive Resources to Operational Activities and Operational Flows. 
• May show the Capabilities the Operational Activities support. 
• May trace Physical Active Resources to the Operational Activity. 
• May trace Services to the Operational Activity. 

 
Representation 
• Hierarchy chart. 
• Activity diagram. 
• Process diagram. 
• Collaboration Diagram. 
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27.1 L4 NAF IM Viewpoint 

 

27.2 L4 ArchiMate Viewpoint 
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Logical Event # Logical Event Business event 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Node # Actor Business actor 
Node # Logical Application Application component 
Node # Logical Equipment Equipment 
Node # Logical Technology Node 
Node # Node Grouping 
Node # Role Business role 
Operational Activity # Operational Activity Business process 
Operational Flow # Operational Flow Business collaboration 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Role # Role Business role 
Service # Application Service Application service 
Service # Business Service Business service 
Service # Technology Service Technology service 

 

27.3 L4 Implementation Guidance 

Operational Activities in this viewpoint are represented as business processes. Nodes are represented as 
groupings, and in the context of this viewpoint they can also be the Node subtypes detailed in Section 4.2. 
The Role is represented as a business role.  
The Node or its subtypes are either assigned to or associated with the Role depending on the ArchiMate 
layer. The Node, it’s subtypes or Role are either assigned to or associated with the Operational Activities 
depending on the ArchiMate layer and element type. Operation Activities trigger Operational Activities. 
Logical Events are represented as business events and they can either trigger or be triggered by 
Operational Activities. The Operation Flow can be represented as business collaboration. This is the 
objectification of the flow relation between the Operational Activity. The option of using a business 
collaboration or flow relations depends on the tooling constraints and level of detail required for modelling 
the scenario. The Operational Control Flow is represented with a triggering relation. 
The mapped Logical Passive Resources are detailed in Section 4.4 and can have an access relation between 
either the Operation Flow or an association to the flow relation between Operational Activities. 
Services exist at three layers within ArchiMate: business, application and technology. They can each serve 
the Operational Activity. The mapped Physical Active Resources are detailed in Section 4.2 that are 
relevant for the viewpoint can serve the Operational Activity. 
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27.4 L4 ArchiMate Example 

 

«Role»
SAR Asset

Controller Role

«Operational Activity»
Reports Problem

«Operational Activity»
Log Distress

«Operational Activity»
Assess Situation

«Operational Activity»
Deploy Assets

«Operational Activity»
Respond to Situation

«Node»
Waterborne Rescue

«Node»
Vessel in Distress

«Node»
Regional Coordination

Center
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28 L5 - LOGICAL STATES 
 

Purpose Usage & Concerns Addressed 
The L5 Viewpoint is concerned with the 
identification and definition of the possible states 
or modes a Node may have, and the possible 
transitions between those States. 

• User Requirements Specification. 
• Analysis of business events. 
• Behavioural analysis. 

 
Scope 
• Shall contain all Logical States of Logical Active Resources relevant for the entity of interest. 
• Shall contain Logical Transitions between Logical States. 
• May show Logical events triggering the Logical Transitions. 
• May show Logical Modes of an Operational Activity or Logical Function that are enabled by the Logical 
State. 
• May show Logical States Groupings of Logical States, and their groupings. 

 
Representation 
• Topological (Connected Shapes). 
• Finite State diagram. 
• State transition diagram. 

28.1 L5 NAF IM Viewpoint 

 

Logical Mode

Logical State

Logical Active Resource

Logical State Group

Logical Event

Logical Transition

aggregates
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aggregates
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Logical Transition

Logical FunctionOperational Activity

enables

has

enables

has
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28.2 L5 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Event # Logical Event Business event 
Logical Function # Application Function Application function 
Logical Function # Business Function Business function 
Logical Function # Technology Function Technology function 
Logical Mode # Mode Business event 
Logical State # Application State Application event 
Logical State # Business State Business event 
Logical State # Technology State Technology event 
Logical State Group # Application State Application event 
Logical State Group # Business State Business event 
Logical State Group # Technology State Technology event 
Logical Transition # State Transition Business interaction 
Operational Activity # Operational Activity Business process 
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28.3 L5 Implementation Guidance 

Logical States, represent as events, exist at three layers within ArchiMate: business, application and 
technology. The mapped Logical Active Resources are detailed in Section 4.2 and they are assigned to their 
corresponding layered ArchiMate state. The Logical Transition can be represented as either a trigger 
relation between the states or as a business interaction that is associated with the trigger relation. The 
option of using business interactions or triggering relations depends on the tooling constraints and level of 
detail required for modelling the scenario. States trigger other states at all ArchiMate layers; this is not 
shown in the viewpoint. 
A business event represents a Logical Event and can trigger the Logical Transition. Note that the specialism 
of business event # Logical Event is used. 
Logical Functions, represented as functions, exist at three layers within ArchiMate: business, application 
and technology. States can serve corresponding layered functions. The states can also serve Operation 
Activities, represented as business processes. The Operation Activity and functions can be associated with 
a Logical Mode, represented as a business event. 
Although in the NAF IM viewpoint the Logical Active Resource is shown, on this viewpoint the Node 
subtypes are encouraged, as it’s expected that they have been elaborated in the L3. Therefore # Nodes 
aren’t shown on the viewpoint, they are however permitted as shown in the example. 

28.4 L5 ArchiMate Example 

 
«Actor»

Crew

«Business State»
Location Determined

«Business State»
Waiting for Distress

signal

«Business State»
In need of rescue

«Business State»
Rescued

«Node»
Regional Coordination

Center

«Logical Event»
Search Exit

«Logical Event»
Start Search



 
 

84 NAFv4.1 ArchiMate 

29 L6 - LOGICAL SEQUENCE 
 

Purpose Usage & Concerns Addressed 
The L6 Viewpoint is concerned with identifying the 
chronological sequence of activities of Active 
Resource (Logical) elements and/ or Logical Flows 
in a scenario. 

• Operational Planning. 
• User Requirements Specification. 
• Analysis of operational events. 
• Sequences of interactions between nodes. 
• Behavioural analysis. 
• Service Orchestration. 
• Operational test scenarios. 

 
Scope 
• Shall contain Logical Lifelines representing Logical Active Resources. 
• Shall contain the Logical Interactions between Logical Lifelines. 
• May show Logical Events that trigger Logical Interactions. 
• May show Operational Activities or Logical Functions related to Logical Interactions. 

 
Representation 
• Sequence diagram. 
• Event-trace diagram. 
• Timing diagram. 

29.1 L6 NAF IM Viewpoint 

 

Logical Event

Logical Lifeline

Logical Active Resource

Logical Interactiontriggers

represents a timeline of

Logical Interaction

Operational Activity

Logical Function
relates to

relates to
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29.2 L6 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Event # Logical Event Business event 
Logical Function # Application Function Application function 
Logical Function # Business Function Business function 
Logical Function # Technology Function Technology function 
Logical Interaction # Interaction Business interaction 
Logical Lifeline # Logical Lifeline Business process 
Operational Activity # Operational Activity Business process 

 
 
 
 
 
 
 
 

# Logical Event # Interaction

# Operational
Activity

# Logical
Application

# Logical
Technology# Actor # Logical

Equipment

# Logical Lifeline # Technology
Function

# Application
Function

# Business
Function
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29.3 L6 Implementation Guidance 

Logical Lifelines are represented as business processes with the specialism # Logical Lifeline. The mapped 
Logical Active Resources are detailed in Section 4.2 and are associated with the # Logical Lifeline. Logical 
Interactions are represented as business interactions with the specialism # Interaction. They are the 
objectification of the trigger relation between Logical Lifelines. The option of using interactions or 
triggering relations depends on the tooling constraints and level of detail required for modelling the 
scenario. 
A business event represents a Logical Event and can trigger the # Interaction. Logical Functions, 
represented as functions, exist at three layers within ArchiMate: business, application and technology and 
are served by the # Interaction. The # Interaction can also serve Operational Activities, represented as 
business processes. 
Although in the NAF IM viewpoint the Logical Active Resource is shown, on this viewpoint the Node 
subtypes are encouraged, as it’s expected that they have been elaborated in the L3. Therefore # Nodes 
aren’t shown on the viewpoint, they are however permitted as shown in the example. 

29.4 L6 ArchiMate Example 

 

«Logical Equipment»
Onshore Rescue Vessel

«Logical Lifeline»
Search Lifeline

«Logical Lifeline»
SAC Lifeline

«Logical Lifeline»
Rescue Vessel

Lifeline

request rescue

control rescue

status

status

«Node»
SAR Asset
Controller

«Node»
Search
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30 L7 - INFORMATION MODEL 
 

Purpose Usage & Concerns Addressed 
The L7 Viewpoint is concerned with identifying 
Information Products, Information Entities and 
their relationships. 

• Information Requirements. 
• Message Requirements. 
• Information Models. 
• Information architecture. 
• Information product hierarchy. 

 
Scope 
• Shall contain Information Entities relevant for the entity of interest. 
• May show an Information Model that specifies the Information Entities. 
• May show Information Attributes that are part of the Information Entity. 
• May show Information Attribute Types relating to Information Attributes. 
• May show Information Products that the Information Model represents. 

 
Representation 
• Entity-Relationship diagram. 
• Class diagram. 

30.1 L7 NAF IM Viewpoint 

 

30.2 L7 ArchiMate Viewpoint 

 
 
 
 

Information Attribute

Information Attribute
Type

Information EntityInformation Model

aggregates

has

specifies
Information Product

represents

# Information
Object
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Information Attribute # Information Object Business object 
Information Attribute Type # Information Object Business object 
Information Entity # Information Object Business object 
Information Model # Information Object Business object 
Information Product # Information Object Business object 

 

30.3 L7 Implementation Guidance 

Information Entities, Models, Products, Attributes and Attribute Types are all represented as business 
objects with the specialism # Information Object. The can have specialization and aggregation relationships 
between them. 

30.4 L7 ArchiMate Example 

 

«Information Object»
Informal Situation Report

«Information Object»
Situational Report

Template

«Information Object»
Tracks

«Information Object»
Terrain Information

«Information Object»
Reporting Unit
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31 L8 - LOGICAL CONSTRAINTS 
 

Purpose Usage & Concerns Addressed 
The L8 Viewpoint is concerned with the 
identification and description of Logical Constraints 
and Logical Requirements 

• User Requirements Specification (Non-
Functional). 
• Definition of business rules. 
• Identification of operational constraints. 

 
Scope 
• Shall contain Logical Requirements that relate to Logical Constraints relevant for the entity of interest. 
• Shall contain Logical Active Resources, Logical Behaviour and Logical Passive Resources that these 
Logical Constraints or Logical Requirements apply to. 
• May show Logical Specifications that group Logical Constraints and Logical Requirements. 
• May show Logical Rationale relating to Logical Constraints. 
• May trace Logical Rationale to Strategic Constraints. 

 
Representation 
• Structured Text. 
• Business rules diagram. 
• Matrix Table. 
• Parametric diagram. 

31.1 L8 NAF IM Viewpoint 

 

Logical Rationale

Logical Constraint

Logical Active Resource Logical Passive
Resource

Logical Requirement

Logical Behavior

Logical Specification

Strategic Constraint

originates from

applies to

originates from

aggregates

relates to

applies to

applies to

applies to

aggregates

applies to

applies to
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31.2 L8 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Behaviour # Application Function Application function 
Logical Behaviour # Business Function Business function 
Logical Behaviour # Operational Activity Business process 
Logical Behaviour # Technology Function Technology function 
Logical Constraint # Constraint Requirement 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Logical Rationale # Rationale Driver 
Logical Requirement # Requirement Requirement 
Logical Specification # Logical Specification Grouping 
Logical Specification # Requirement Requirement 
Strategic Constraint # Constraint Requirement 
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31.3 L8 Implementation Guidance 

Logical Requirements and Logical Constraints are represented as requirements. They are realized by the 
mapped Logical Active Resources, Logical Behaviour and Logical Passive Resources detailed in Section 4. 
# Constraints can influence a # Requirement. Logical Rationale are represented as drivers. These # 
Rationale can influence a # Constraint. # Constraints can influence # Rationale which captures the 
relationship between Logical Rationale and Strategic Constraints. 
The Logical Specification can be represented as either a grouping that aggregates Requirements and 
Constraints or as aggregations between Requirements and Constraints. 
Although in the NAF IM viewpoint the Logical Active Resource is shown, on this viewpoint the Node 
subtypes are encouraged, as it’s expected that they have been elaborated in the L3. Therefore # Nodes 
aren’t shown on the viewpoint, they are however permitted as shown in the example. 

31.4 L8 ArchiMate Example 

 

«Constraint»
Must be Scalable

«Constraint»
Must be able to integrate new

assets

«Requirement»
Requires access to all location

data of all authorities

«Constraint»
Must be able to operate

independently

«Constraint»
Must be operated permanently

«Node»
Search

«Node»
Tactical C2

«Node»
Regional Coordination

Center



 
 

92 NAFv4.1 ArchiMate 

32 LR - LOGICAL ROADMAP 
 

Purpose Usage & Concerns Addressed 
The Lr Viewpoint is concerned with Identifying 
Logical Roadmaps with Logical Milestones related 
to the evolution of Resource Building blocks 

• Acquisition Planning. 
• Portfolio / Programme Management. 
• Project Performance Reporting. 
• Project management and control (including 
delivery timescales). 
• Project dependencies and the identification of 
associated risk. 
• Through Life Management Planning. 

 
Scope 
• Shall contain Logical Milestones that define the Logical Readiness Levels. 
• Shall contain the Logical Active Resources that the Logical Readiness Level fulfils. 
• May trace Logical Readiness Levels to Capability Increments. 
• May show Logical Projects and how they schedule Logical Milestones and define the evolution of the 
Logical Active Resource. 

 
Representation 
• Timeline View. 
• Augmented chart in style of a Gantt Chart. 
• Portfolio Dashboard. 

32.1 Lr NAF IM Viewpoint 

 

Logical Milestone

Logical Readiness
Level Logical Active Resource

Capability Increment

relates to

defines

fulfils

Logical Project
schedules

defines evolution of
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32.2 Lr ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability Increment # Capability Capability 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Active Resource # Node Grouping 
Logical Milestone # Milestone Implementation event 
Logical Project # Work Package Work package 
Logical Readiness  Level # Readiness Level Plateau 

 

32.3 Lr Implementation Guidance 

Logical Milestones are represented as implementation events. Logical Readiness Levels are represented as 
plateaus that are associated with the implementation event. The # Readiness level aggregates the mapped 
Logical Active Resources detailed in Section 4.2 relevant for the viewpoint. Logical Projects are 
represented as work packages. 
Logical Milestones are associated with the # Logical Readiness Level. Alternatively, they may be captured 
as attributes on the # Readiness Level and so to represent the schedules relation, work packages can 
realize the # Readiness Level and be associated with Logical Milestone. 
Work packages can realize each of the mapped Logical Active Resources. 

# Capability

# Logical
Technology

# Logical
Equipment

# Logical
Application# Actor

# Work Package

# Milestone

# Readiness Level

# Node
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32.4 Lr ArchiMate Example 

 

«Readiness
Level»

WBR Low

«Readiness
Level»

WBR High

«Milestone»
Up to date

maintenance

«Milestone»
Trained Personnel

«Milestone»
Latest Software

«Node»
Waterborne

Rescue
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33 P1 - RESOURCE TAXONOMY 
 

Purpose Usage & Concerns Addressed 
The P1 Viewpoint is concerned with the 
Identification of Active Resources (Physical) and 
Physical Behaviour and their mapping to 
Conceptual, Service and Logical building blocks and 
their organization into taxonomies. 

• Capability Delivery. 
• Service Implementation. 
• Identifying Resource Taxonomies. 
• Identification of applicable protocols. 
• Forecasting technology readiness against time. 
• HR trends analysis. 
• Recruitment planning. 
• Planning technology insertion. 
• Input to options analysis. 

 
Scope 
• Shall contain all Physical Active Resources organized into specialization taxonomies and Resource 
Functions, and their groupings, relevant for the entity of interest. 
• May show linkages between Physical Active Resources and Resource Functions. 
• May show Physical Active Resources organized into Capability Configurations. 
• May show Physical Passive Resources that Physical Active Resources depend on. 
• May trace Capabilities to Capability Configurations. 
• May trace Physical Active Resources to Logical Active Resources. 
• May trace Resource Functions to Service Functions and Logical Behaviour. 

 
Representation 
• Tabular. 
• Mapping (matrix). 
• Composite Structure Diagram. 
• Block diagram. 
• Class Diagram 
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33.1 P1 NAF IM Viewpoint 

 

Physical Active
Resource

Resource Function

Service Function

Capability Configuration

aggregates

aggregates
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33.2 P1 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability # Capability Capability 
Capability Configuration # Capability Configuration Grouping 
Logical Active Resource # Actor Business actor 
Logical Active Resource # Logical Application Application component 
Logical Active Resource # Logical Equipment Equipment 
Logical Active Resource # Logical Technology Node 
Logical Active Resource # Role Business role 
Logical Function # Application Function Application function 
Logical Function # Business Function Business function 
Logical Function # Technology Function Technology function 
Operational Activity # Operational Activity Business process 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Resource Function # Application Process Application process 
Resource Function # Business Process Business process 
Resource Function # Technology Process Technology process 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 

 

# Equipment# Person # Application# Organization# Post

# Material

# Logical
Application# Actor# Role # Logical

Technology
# Logical
Equipment

# Business
Function

# Technology
Function
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Function
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33.3 P1 Implementation Guidance 

Physical Active Resources are represented by a variety of ArchiMate elements at four layers: business, 
application, technology and physical; the mappings are detailed in Section 4.2. All mapped Physical Active 
Resources specialize and can compose other Physical Active Resources.  
Resource Functions are represented as processes at the business, application and technology layers. Each 
Physical Active Resource is assigned to and is served by the corresponding process layer. 
Capability Configurations are represented as groupings. They can aggregate all the Physical Active 
Resources and can realize capabilities. Where relevant, the Physical Active Resources can access the 
mapped Physical Passive Resources detailed in Section 4.4. 
Logical Active Resources can either be specialized by or associated with Physical Active Resources. The 
mappings of Logical Active Resources are detailed in Section 4.2. 
Service Functions and Logical Functions are represented as the same functions at three layers within 
ArchiMate: business, application and technology. They can aggregate the processes (Resource Functions). 
Processes (Resource Functions) can also serve Operational Activities represented as business processes. 

33.4 P1 ArchiMate Example 

 

«Logical Equipment»
Communication

Device

«Equipment»
DSC Radio

«Equipment»
VHF Radio

«Equipment»
MF Radio

«Equipment»
HF Radio

«Capability Configuration»
Heli Squadron

«Technology Process»
Transmit Voice Communication
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34 P2 - RESOURCE STRUCTURE 
 

Purpose Usage & Concerns Addressed 
The P2 viewpoint is concerned with the 
identification of how resources are structured and 
their dependencies to other resources, 

• Physical Architecture. 
• Systems Engineering / Design. 
• Organizational Design. 
• Systems Integration. 
• System Requirements Specification. 
• Definition of system concepts. 
• Definition of system options. 
• Human – System interactions. 
• Interface requirements capture. 
• Capability integration planning. 
• System integration management. 
• Operational planning (capability configuration 
definition). 

 
Scope 
• Shall contain Physical Active Resources and Physical Passive Resources organized into Capability 
Configurations. 
• Shall contain the structural organization of Physical Active Resources and Physical Passive Resources. 
• Shall contain dependencies between Physical Active Resources and Physical Passive Resources. 
• May show Resource interactions between Physical Active Resources. 
• May trace Resource Interactions to Logical Interactions defined in L3. 
• May trace Physical Passive Resources to Logical Passive Resources. 

 
Representation 
• Composite structure diagram. 
• Block diagram. 
• Internal Block diagram. 
• Physical Block diagram. 
• Class diagram. 
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34.1 P2 NAF IM Viewpoint 
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34.2 P2 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability Configuration # Capability Configuration Grouping 
Logical Interaction # Interaction Business interaction 
Logical Passive Resource # Information Object Business object 
Logical Passive Resource # Logical Energy Material 
Logical Passive Resource # Logical Material Material 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Resource Interaction # Resource Interaction Technology interaction 

 
 
 
 
 

# Equipment# Person # Application# Organization# Post

# Material

# Resource
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# Interaction
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# Device # Communication
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34.3 P2 Implementation Guidance 

Physical Active Resources are represented by a variety of ArchiMate elements at four layers: business, 
application, technology and physical; the mappings are detailed in Section 4.2. All mapped Physical Active 
Resources specialize and can compose other Physical Active Resources. All the serving relations between 
the mapped Physical Active Resources are not shown on this viewpoint but where ArchiMate permits, they 
are allowed.  
Physical Passive Resources are detailed in Section 4.4. The Physical Active Resources access the Physical 
Passive Resources. Capability Configurations are represented as groupings. They aggregate the Physical 
Active and Passive Resources. 
Resource Interactions are represented as either flow relations between the Physical Active Resources or as 
technology collaborations (specialized as # Resource Interactions) that are associated with the flow 
relations. All mapped Physical Active Resources can flow to each other (not shown on the viewpoint). 
Where Logical Interactions have been represented as business interactions (specialized as # Interaction), 
they can be realized by the # Resource Interaction. 
The Physical Passive Resources can realize the relevant mapped Logical Passive Resources detailed in 
Section 4.4. 

34.4 P2 ArchiMate Example 

 

«Capability Configuration»
Heli Squadron

«Equipment»
DSC Radio

«Equipment»
NH90

«Equipment»
NH90 Rescue

Hoist

«Data Object»
Voice Data

«Post»
Winch Operator

«Post»
NH90 Pilot



 103 NAFv4.1 ArchiMate 

35 P3 - RESOURCE INTERACTIONS 
 

Purpose Usage & Concerns Addressed 
The P3 Viewpoint is concerned with identifying all 
relevant interactions between active resources. 

• Interface Specification. 
• Systems Engineering. 
• System Requirements. 
• Identification of interactions. 
• Identification of applicable protocols. 
• Description of system communication paths. 
• Bandwidth and capacity analysis. 
• Detailed definition of data flows. 
• Detailed definition of resource flows. 
 

 
Scope 
• Shall contain the Resource Interactions between the Physical Active Resources. 
• Shall contain the Standards and Protocols the Resource Interaction conforms to. 
• Shall contain the Protocols that the Physical Active Resource implements. 
• May trace Resource Interactions to Logical Interactions. 
• May show Physical Passive Resources that the Resource Interaction conveys. 

 
Representation 
• Block diagram. 
• Internal Block diagram. 
• Physical Block diagram. 
• Class diagram. 
• Tabular. 
 

35.1 P3 NAF IM Viewpoint 

 

Protocol Standard

Physical Passive
Resource

Logical Interaction

Resource Interaction

Physical Active
Resource

implements

realizes

conveys

Resource Interaction

is equal to

conforms to conforms to
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35.2 P3 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Interaction # Interaction Business interaction 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Protocol # Protocol Artifact 
Resource Interaction # Resource Interaction Technology interaction 
Standard # Standard Contract 
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35.3 P3 Implementation Guidance 

Physical Active Resources are represented by a variety of ArchiMate elements at four layers: business, 
application, technology and physical; the mappings are detailed in Section 4.2.  
Resource Interactions are represented as either flow relations between the Physical Active Resources or as 
technology collaborations (specialized as # Resource Interactions) that are associated with the flow 
relations.  
Protocols are represented as artifacts, they can be associated with the relevant Physical Active Resources 
and realized by the # Resource Interaction. Standards are represented as contracts that have an access 
relation to the # Resource Interaction. 
Where Logical Interactions have been represented as business interactions (specialized as # Interaction), 
they can be realized by the # Resource Interaction. 
Physical Passive Resources are detailed in Section 4.4, they can have an access relation to the # Resource 
Interaction or if the Resource Interaction was modelled with flow relations, they can be associated with 
them. 

35.4 P3 ArchiMate Example 

 

«Equipment»
DSC Radio

«Standard»
VHF

«Resource Interaction»
Radio Channel

«Data Object»
Voice Data

«Facility»
Command Post

«Protocol»
VHF Mode 2
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36 P4 - RESOURCE FUNCTIONS 
 

Purpose Usage & Concerns Addressed 
The P4 Viewpoint is concerning the Identification 
of the Resource Functions carried out by 
Resources, and Resource Flows between Resources 

• Capability-Based Acquisition. 
• Business Process Modelling. 
• Workflow Modelling. 
• Human-Machine Interaction Specifications. 
• Description of task workflow. 
• Identification of functional system requirements. 
• Functional decomposition of systems. 
• Relate human and system functions. 

 
Scope 
• Shall contain the Physical Active Resources that use or perform a Resource Function. 
• Shall contain the Physical Passive Resources that the Resource Function uses or delivers. 
• Shall contain Functional Flows and Resource Flows between Resource Functions. 
• May show the Physical Passive Resources that the Resource Flow conveys. 
• May trace Resource Functions to Logical Behaviour or Service Functions. 

 
Representation 
• Topological (connected shapes). 
• Activity diagram. 
• Collaboration diagram. 
• Process diagram. 
• Functional Breakdown (decomposition). 

36.1 P4 NAF IM Viewpoint 

 

Operational Activity

Physical Active
Resource

Service Function

Resource Function

Resource Flow

Physical Passive
Resource

Logical Function

realizes

uses

realizes

delivers

realizes

conveys

functional flow

Resource Flow

is equal toperforms

uses

aggregates
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36.2 P4 ArchiMate Viewpoint 
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Function # Application Function Application function 
Logical Function # Business Function Business function 
Logical Function # Technology Function Technology function 
Operational Activity # Operational Activity Business process 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Resource Flow # Resource Interaction Technology interaction 
Resource Function # Application Process Application process 
Resource Function # Business Process Business process 
Resource Function # Technology Process Technology process 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 

36.3 P4 Implementation Guidance 

Resource Functions are represented as processes at the business, application and technology layers. 
Physical Active Resources are represented by a variety of ArchiMate elements at four layers: business, 
application, technology and physical; the mappings are detailed in Section 4.2.  
Each Physical Active Resource is assigned to (performs) and is served by (uses) the corresponding layered 
process(Resource Function). The serving relation between the Physical Active Resources and the Resource 
Functions are not shown on this viewpoint, but are visualised on the L4-P4. 
Resource Functions can aggregate other Resource Functions. 
The Resource Flow can be represented as flow relations or as technology interactions associated with the 
flow relations. This is the objectification of the flow relation between the Resource Functions. The option 
of using resource interactions or flow relations depends on the tooling constraints and level of detail 
required for modelling the scenario. The Function Flow is represented with a triggering relation. 
The mapped Physical Passive Resources are detailed in Section 4.4 and can have an access relation 
between either the # Resource Interaction or the Resource Functions. 
Logical Functions and Service Functions are represented as functions at three layers within ArchiMate: 
business, application and technology. They can aggregate the corresponding layered process. 
Operational Activities are represented as business processes that can be served by the Resource Functions. 



 109 NAFv4.1 ArchiMate 

36.4 P4 ArchiMate Example 
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37 L4-P4 - ACTIVITY TO FUNCTION MAPPING 
 

Purpose Usage & Concerns Addressed 
The L4-P4 Viewpoint is concerned with addressing 
the linkage between Resource Functions and 
Operational Activities specified in L4 as well as the 
linkage between Resource Functions and Service 
Functions specified in the S4. 

• Requirements Definition. 
• Process Mapping. 
• Tracing functional system requirements to user 
requirements. 
• Tracing solution options to requirements. 
• Identification of overlaps. 

 
Scope 
• Shall contain the traceability between Resource Functions and Operational Activities. 
• May trace Resource Functions to Service Functions defined in the S4. 
• May show Physical Active Resources that use or perform the Resource Functions. 

 
Representation 
• Tabular. 
• Matrix. 
• Diagram. 

37.1 L4-P4 NAF IM Viewpoint 

 

Service Function

Operational Activity

Resource Function

realizes

realizes

Physical Active
Resourceuses

performs
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37.2 L4-P4 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Operational Activity # Operational Activity Business process 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # System Software System software 
Resource Function # Application Process Application process 
Resource Function # Business Process Business process 
Resource Function # Technology Process Technology process 
Service Function # Application Function Application function 
Service Function # Business Function Business function 
Service Function # Technology Function Technology function 

 

37.3 L4-P4 Implementation Guidance 

Resource Functions are represented as processes at the business, application and technology layers. 
Operational Activities are represented as business processes that are served by the Resource Functions. 
Physical Active Resources are represented by a variety of ArchiMate elements at four layers: business, 
application, technology and physical; the mappings are detailed in Section 4.2. Each Physical Active 
Resource is assigned to and is served by the corresponding layered process. 
Service Functions are represented as functions at three layers within ArchiMate: business, application and 
technology. They can aggregate the corresponding layered process (Resource Function). 
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37.4 L4-P4 ArchiMate Example 

 

«Operational Activity»
Control Rescue

«Business Function»
Rescue

«Business Process»
Conduct Tactical Response
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38 P5 - RESOURCE STATES 
 

Purpose Usage & Concerns Addressed 
The P5 Viewpoint is concerned with Resource 
Types changing State in response to events and 
other stimuli. 

• Systems Engineering. 
• Safety Cases. 
• Definition of states, events and state transitions 
(behavioural modelling). 

 
Scope 
• Shall contain all Resource States of Physical Active Resources relevant for the entity of interest. 
• Shall contain Resource Transitions between Resource States. 
• May show Resource Events triggering Resource Transitions. 
• May show Resource Modes of a Resource Functions that are enabled by the Resource State. 
• May show Resource States Groupings of Resource States, and their groupings. 
• May trace Resource States to Logical States. 

 
Representation 
• State Transition diagram. 
• Finite State diagram. 

38.1 P5 NAF IM Viewpoint 

 

Resource Mode

Resource Transition

Resource State

Logical State

Resource State Group

Resource Event

Physical Active
Resource

aggregates

relates to

triggers

has

aggregates

Resource Transition

is equal to

Resource Function
enables

has
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38.2 P5 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical State # Application State Application event 
Logical State # Business State Business event 
Logical State # Technology State Technology event 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Resource Event # Resource Event Business event 
Resource Function # Application Process Application process 
Resource Function # Business Process Business process 
Resource Function # Technology Process Technology process 
Resource Mode # Resource Mode Business process 
Resource State # Application Resource State Application event 
Resource State # Business Resource State Business event 
Resource State # Technology Resource State Technology event 
Resource State Group # Application Resource State Application event 
Resource State Group # Business Resource State Business event 
Resource State Group # Technology Resource State Technology event 
Resource Transition # Resource State Transition Business collaboration 

 

# Business
Resource State

# Equipment

# Person

# Application

# Technology
Resource State

# Application
Resource State

# Post

# Organization

# Resource State
Transition

# Resource Event

# Business State # Technology
State

# Application
State

# Resource Mode

# Device

# Communication
Network

# System Software

# Technology
Process

# Application
Process

# Business
Process
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38.3 P5 Implementation Guidance 

Resource States, represented as events exist at three layers within ArchiMate: business, application and 
technology. Physical Active Resources are represented by a variety of ArchiMate elements at four layers: 
business, application, technology and physical; the mappings are detailed in Section 4.2 and are associated 
with their corresponding ArchiMate layered state. 
The Resource Transition can be represented as either a trigger relation between the states or as a business 
collaboration that is associated with the trigger relation. The option of using business collaborations or 
triggering relations depends on the tooling constraints and level of detail required for modelling the 
scenario. States trigger other states at all ArchiMate layers; this is not shown in the viewpoint. 
A business event represents a Resource Event and can trigger the Resource Transition (the # Resource 
State Transition). 
Resource Functions are represented as processes at the business, application and technology layers. The 
Resource States can serve these layered processes. The Resource States can also specialize the 
corresponding layered Logical State defined in the L5. The Logical states and processes can be associated 
with a Resource Mode, represented as a business event. 

38.4 P5 ArchiMate Example 

 

«Business Resource State»
Moving to Extraction Point

«Business Resource State»
Hovering

«Business Resource State»
Rescuing

«Business Resource State»
Exiting

«Resource State Transition»
Transition to Hovering

«Resource State Transition»
Subject Identified

«Resource State Transition»
Subject Rescued

«Resource Event»
Execution Point Arrival

«Equipment»
NH90

«Business Process»
Execute Hover Manoeuvre

«Business Process»
Deploy Rescue Winch

«Business Process»
Confirm Extraction Complete

«Business Resource State»
Tactical operation in progress
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39 P6 - RESOURCE SEQUENCE 
 

Purpose Usage & Concerns Addressed 
The P6 Viewpoint is concerned with identifying the 
chronological sequence of the Interactions 
between active Resources in a scenario. 

• Message Handling. 
• Complex System Behaviours. 
• Security Modelling. 
• Analysis of resource events impacting operation. 
• Behavioural analysis. 

 
Scope 
• Shall contain Resource Lifelines representing Physical Active Resources. 
• Shall contain the Resource Interactions between Resource Lifelines. 
• May show Resource Events that trigger Resource Interactions. 
• May show Resource Functions related to Resource Interactions. 

 
Representation 
• Topological (connected shapes). 
• Sequence Diagram. 

39.1 P6 NAF IM Viewpoint 

 

Physical Active
Resource

Resource Interaction

Resource Lifeline

Resource Event

triggers

represents a timeline of

Resource Interaction

is equal to

Resource Function
relates to
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39.2 P6 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Resource Event # Resource Event Business event 
Resource Function # Application Process Application process 
Resource Function # Business Process Business process 
Resource Function # Technology Process Technology process 
Resource Interaction # Resource Interaction Technology interaction 
Resource Lifeline # Resource Lifeline Technology process 

 

39.3 P6 Implementation Guidance 

Resource Lifelines are represented as business processes with the specialism # Resource Lifeline. Physical 
Active Resources are represented by a variety of ArchiMate elements at four layers: business, application, 
technology and physical; the mappings are detailed in Section 4.2 and are associated with the Resource 
Lifeline.  
Resource Interactions are represented as technology interactions with the specialism # Resource 
Interaction. They are the objectification of the trigger relation between Resource Lifelines. The option of 
using technology interactions or triggering relations depends on the tooling constraints and level of detail 
required for modelling the scenario. 
A business event represents a Resource Event and can trigger the # Resource Interaction. 
Resource Functions are represented as processes at the business, application and technology layers and 
can be served by the Resource Interaction. 

# Person # Application # Equipment

# Resource
Interaction

# Organization

# Resource Event

# Resource
Lifeline

# Device # Communication
Network# System Software

# Facility # Distribution
Network

# Business
Process

# Application
Process

# Technology
Process

# Post
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39.4 P6 ArchiMate Example 

 

«Equipment»
DSC Radio

«Resource Lifeline»
Command Post

Lifeline

«Resource Lifeline»
DSC Radio Lifeline

«Resource Interaction»
Situational Response

«Facility»
Command Post
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40 P7 - DATA MODEL 
 

Purpose Usage & Concerns Addressed 
The P7 Viewpoint is concerned with the identifying 
Data Products, Data Entities and their 
relationships. 

• System Design. 
• Data Schema Design. 
• Message / Protocol Specification. 
• Data Architecture. 
• Database Design. 
• Specifying the data elements exchanged between 
systems 
• Security Modelling. 

 
Scope 
• Shall contain Data Entities relevant for the entity of interest. 
• May show the Data Model that specifies the Data Entities. 
• May show Data Attributes that are part of the Data Entity. 
• May show groupings of Data Entities. 
• May show Data Attribute Types relating to Data Attributes. 
• May show Physical Characteristics of Data Attributes and Data Entities. 
• May trace Data Models to Information Models. 

 
Representation 
• Formal text data modelling language. 
• Topological (connected shapes). 
• Class diagram. 
• Entity-Relation diagram 
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40.1 P7 NAF IM Viewpoint 

 

40.2 P7 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Actual Data Product # Data Object Data object 
Data Attribute # Data Object Data object 
Data Attribute Type # Data Object Data object 
Data Entity # Data Object Data object 
Data Model # Data Object Data object 
Information Model # Information Object Business object 
Physical Characteristic # Data Object Data object 

Data Model

Data Entity

Information Model

Data Attribute

Data Attribute Type Physical Characteristic

has

has

specifies

aggregates

realizes

has

aggregates

Actual Data Product
represents

# Data Object

# Information
Object
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40.3 P7 Implementation Guidance 

Data Entities, Modes, Products, Attributes and Attribute Types are all represented as data objects that can 
have specialization and aggregation relationships between them. 
Information Models can be represented as business objects with the specialism # Information Object and 
can be realized by a data object. 

40.4 P7 ArchiMate Example 

 

«Data Object»
Search Object

«Data Object»
Search Status

«Data Object»
SAR Data Model

«Data Object»
Last Known

Position

«Data Object»
Standard Person

Info

«Data Object»
Search Area

«Data Object»
Last Known
Position Time

«Data Object»
Source of Report

«Data Object»
Last Known

Position
Coordinates

«Data Object»
Location

«Data Object»
Search Area
Coordinates

«Data Object»
Person Location

«Data Object»
Operational

Search Status
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41 P8 - RESOURCE CONSTRAINTS 
 

Purpose Usage & Concerns Addressed 
The P8 Viewpoint is concerned with Identification 
and description of Resources Constraints and 
Resource Requirements 

• Non-Functional Requirements. 
• Safety Cases. 
• Definition of implementation logic. 
• Identification of resource constraints. 
 

 
Scope 
• Shall contain Resource Requirements that relate to Resource Constraints relevant for the entity of 
interest. 
• Shall contain Physical Active Resources, Physical Behaviour and Physical Passive Resources that these 
Resource Constraints or Resource Requirements apply to. 
• May show Resource Specifications that group Resource Constraints and Resource Requirements. 
• May show Resource Rationale relating to Resource Constraints. 
• May trace Resource Rationale to Logical Constraints. 

 
Representation 
• Text Document 
• Tabular. 
• Parametric diagram. 
 

41.1 P8 NAF IM Viewpoint 

 

Resource Constraint

Resource Requirement

Resource Specification

Physical Passive
Resource

Physical Active
Resource Resource Rationale

Logical Constraint

Physical Behavior

applies to

aggregates

aggregates

applies to

applies to

applies to

applies to

relates to

originates from

applies to

originates from
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41.2 P8 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Logical Constraint # Constraint Requirement 
Physical Active Resource # Application Application component 
Physical Active Resource # Communication Network Communication network 
Physical Active Resource # Device Device 
Physical Active Resource # Distribution Network Distribution network 
Physical Active Resource # Equipment Equipment 
Physical Active Resource # Facility Facility 
Physical Active Resource # Organization Business actor 
Physical Active Resource # Person Business actor 
Physical Active Resource # Post Business role 
Physical Active Resource # System Software System software 
Physical Behaviour # Application Process Application process 
Physical Behaviour # Business Process Business process 
Physical Behaviour # Technology Process Technology process 
Physical Passive Resource # Artifact Artifact 
Physical Passive Resource # Data Object Data object 
Physical Passive Resource # Energy Material 
Physical Passive Resource # Material Material 
Resource Constraint # Constraint Requirement 
Resource Rationale # Rationale Driver 
Resource Requirement # Requirement Requirement 
Resource Specification # Requirement Requirement 
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41.3 P8 Implementation Guidance 

Resource Requirements and Resource Constraints are represented as requirements. They are realized by 
the mapped Physical Active Resources, Physical Behaviour and Physical Passive Resources detailed in 
Section 4. 
# Constraints can influence a # Requirement. Resource Rationale are represented as drivers. These # 
Rationale can influence a # Constraint. # Constraints can influence # Rationale which captures the 
relationship between Resource Rationale and Logical Constraints. 
The Resource Specification can be represented as either a grouping that aggregates Requirements and 
Constraints (shown in the L8) or as aggregations between Requirements and Constraints. 

41.4 P8 ArchiMate Example 

 

«Requirement»
24/7 Continuous

Operation

«Requirement»
IP6x

«Constraint»
IP66

«Requirement»
Certified NATO

Secret

«Business Process»
Conduct Tactical Response

«Equipment»
Communication Device
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42 PR - RESOURCE ROADMAP 
 

Purpose Usage & Concerns Addressed 
The Pr Viewpoint is concerned with Resource 
Roadmaps with Resource Milestones related to the 
evolution of Capability Configurations 

• Product Lifecycle Management. 
• Version Control. 
• Release Scheduling. 
• Development of incremental acquisition strategy. 
• Configuration Management. 
• Planning technology insertion. 

 
Scope 
• Shall contain Resource Readiness Levels that Resource Milestones define. 
• Shall contain Capability Configurations that the Resource Readiness Level delivers. 
• May show Resource Projects and how they schedule Resource Milestones and define the evolution of 
the Capability Configuration. 
• May trace Resource Readiness Levels to Logical Readiness Levels. 
• May trace Resource Milestones to Logical Milestones. 

 
Representation 
• Timeline view. 
• Herringbone style diagram. 
• Augmented chart in style of a Gantt Chart. 

42.1 Pr NAF IM Viewpoint 

 

Logical Readiness Level Capability Configuration

Resource Milestone

Resource Readiness
Level

delivers

defines

relates to

Resource Project
schedules

defines evolution of

Logical Milestone
corresponds to
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42.2 Pr ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Capability Configuration # Capability Configuration Grouping 
Logical Milestone # Milestone Implementation event 
Logical Readiness  Level # Readiness Level Plateau 
Resource Milestone # Milestone Implementation event 
Resource Project # Work Package Work package 
Resource Readiness Level # Readiness Level Plateau 

 

42.3 Pr Implementation Guidance 

Resource Milestones are represented as implementation events. Resource Readiness Levels are 
represented as plateaus that are associated with the implementation event. The # Readiness level 
aggregates Capability Configurations, represented as groupings. 
Resource Projects are represented as work packages. Resource Milestones are associated with the 
Readiness Level. Alternatively, they may be captured as attributes on the # Readiness Level and so to 
represent the schedules relation, work packages can realize the # Readiness Level and be associated with 
the # Milestone. Work packages also realize the Capability Configuration. # Milestones and # Readiness 
Levels can have an aggregation to show traceability from those defined in the Lr viewpoint. 

# Milestone

# Work Package

# Capability
Configuration

# Readiness Level
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42.4 Pr ArchiMate Example 

 

«Readiness
Level»

WBR Low

«Milestone»
Up to date

maintenance

«Milestone»
Trained Personnel

«Readiness
Level»

Fleet X Low

«Milestone»
Up to Date

Maintenance

«Milestone»
Trained Personnel

«Capability Configuration»
Maritime Rescue by Surface Fleet

Configuration
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43 A1 - METADATA DEFINITIONS 
 

Purpose Usage & Concerns Addressed 
The A1 is concerned with terminology and 
metadata of different kinds regarding the 
architecture. 

• Architecture element discovery. 
• Security and data protection Management. 
• Summary and Overview. 
• Setting up a glossary for the architecture. 
• Managing architecture metadata. 

 
Scope 
• Shall contain the Glossary Terms relevant for the Architecture Description. 
• May show metadata that characterizes the Architecture Description. 
• May show Contextual Data that characterizes the Architecture Description. 
• May show Standards that describe the Contextual Data. 

 
Representation 
• Tabular. 
• Text. 

43.1 A1 NAF IM Viewpoint 

 

Contextual Data Meta DataGlossary Term

characterizescharacterizes characterizes

Architecture Description

Standard

describes
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43.2 A1 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Description # Architecture Description Product 
Contextual Data # Contextual Data Business object 
Glossary Term # Glossary Term Meaning 
Meta Data # Metadata Business object 
Standard # Standard Contract 

 

43.3 A1 Implementation Guidance 

Architecture Descriptions are represented as products. Glossary terms are represented as meanings and 
are associated with Architecture Descriptions. 
Metadata and Contextual data are represented as business objects that can be associated with the 
Architecture Description. Standards are represented as contracts that can be associated with Contextual 
Data. 

# Metadata# Contextual Data # Glossary Term

# Architecture
Description

# Standard
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43.4 A1 ArchiMate Example 

 

«Architecture Description»
SAR Concept 2025 Model

«Glossary Term»
SAR: Search and Rescue

«Glossary Term»
SIC: Situation Information Coordination

«Glossary Term»
IMSAR: International Maritime Search

and Rescue

«Metadata»
Methodology: TOGAF

«Metadata»
Framework: NAFv4

«Metadata»
Approval Board: C3

Board

«Metadata»
Status: Draft

«Metadata»
Modelling Tool:

Architecture Software

«Contextual Data»
Policy: IMSAR
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44 A2 - ARCHITECTURE PRODUCTS 
 

Purpose Usage & Concerns Addressed 
The A2 Architecture Products Viewpoint is 
concerned with the Architecture Work Products 
that describe or accompany an Architecture. 

• Architecture Content. 
• Stakeholder Management. 
• Summarizing an Architecture. 
• Navigating an Architecture. 

 
Scope 
• Shall contain the Views that make up the Architecture Description and which Viewpoints those Views 
conform to. 
• Shall contain Stakeholders. their concerns and the Viewpoints that frame the Concerns. 
• May show Views that directly address a concern. 
<br> 
 

 
Representation 
• NAF grid representation. 
• Other representations suitable for the architect. 

44.1 A2 NAF IM Viewpoint 

 

Concern

Viewpoint

View

Architecture Description

frames

contains

addresses

governs

Stakeholder

has
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44.2 A2 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Description # Architecture Description Product 
Concern # Concern Driver 
Stakeholder # Stakeholder Stakeholder 
View # View Representation 
Viewpoint # Viewpoint Business object 

 

44.3 A2 Implementation Guidance 

The Architecture Description is represented as a product. It aggregates Views, represented as 
representations with the specialism # View. Viewpoints are represented as business objects. Concerns are 
represented as drivers. Views realize a Viewpoint. Views and Viewpoints influence Concerns. Stakeholders 
are associated with a concern. 

# View

# Architecture
Description # Stakeholder

# Concern

# Viewpoint
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44.4 A2 ArchiMate Example 
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45 A3 - ARCHITECTURE CORRESPONDENCE 
 

Purpose Usage & Concerns Addressed 
The A3 Viewpoint is concerned with implementing 
correspondence between elements of Architecture 
Descriptions (AD). 

• Traceability / dependencies between 
architectures. 
• Re-Use of Architectures. 
• Dependency analysis across architectures. 

 
Scope 
• Shall contain all relevant Architecture Description Elements. 
• Shall contain Element Correspondences that relate to Architecture Description Elements and 
Correspondence Methods that govern them. 
• May show how Architecture Descriptions relate to Architecture Description Elements. 
• May show how Architecture Descriptions relate to Element Correspondences. 

 
Representation 
• Tabular. 
• Diagram. 

45.1 A3 NAF IM Viewpoint 

 

Architecture Description
Element

Element
Correspondence

Architecture Description

relates to

relates to

aggregates

Correspondence
Method

governs
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45.2 A3 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Description # Architecture Description Product 
Architecture Description Element # Architecture Description Element Business object 
Correspondence  Method # Correspondence Method Business process 
Element Correspondence # Element Correspondence Representation 

 

45.3 A3 Implementation Guide 

Architecture Description Elements are represented as business objects. An Element Correspondence is 
represented as a representation that is associated with the Architecture Description Element. 
Correspondence Methods are represented as business processes that have an access relation between 
Element Correspondences. 
The Architecture Description is represented as a product that can aggregate the Architecture Description 
Element and be associated with the Element Correspondence. 

# Architecture
Description

# Element
Correspondence

# Architecture
Description

Element

# Correspondence
Method
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45.4 A3 ArchiMate Example 

 

«Architecture Description»
SAR Concept 2025 Model

«Architecture Description Element»
Combat SAR

«Architecture Description Element»
SAR Reference Architecture

«Element Correspondence»
SAR Concept 2025 implements SAR

Reference Architecture

«Element Correspondence»
SAR Concept 2025 includes combat

SAR

«Correspondence Method»
Embeds Architecture

«Correspondence Method»
Applies Reference
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46 A4 - ARCHITECTURE METHODOLOGY 
 

Purpose Usage & Concerns Addressed 
The A4 is concerned with methodology used in 
developing the architecture. 

• Architecture Management & Review. 
• Architecture project management. 

 
Scope 
• Shall contain the Architecture Projects and the Methodologies it uses and Methodology extensions. 
• May show the Standards that apply to the Methodology. 
• May show the Architecture Description that document the projects. 

 
Representation 
• Tabular. 
• Text Document. 

46.1 A4 NAF IM Viewpoint 

 

Methodology

Standard

Architecture Project

Architecture Description

applies

extends

uses

documents
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46.2 A4 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Description # Architecture Description Product 
Architecture Project # Architecture Project Work package 
Methodology # Architecture Methodology Business process 
Standard # Standard Contract 

 

46.3 A4 Implementation Guidance 

An Architecture Project is represented as a work package. The Architecture Methodology is represented as 
a business process that is associated with the Architecture Project and it specializes other Architecture 
Methodologies. 
Standards are represented as contracts that can have an access relationship with the Architecture 
Methodology. 
The Architecture Description is represented as a product that can be associated with the Architecture 
Project.  

46.4 A4 ArchiMate Example 

 

# Architecture
Description

# Standard

# Architecture
Methodology

# Architecture
Project

«Architecture Description»
SAR Concept 2025 Model

«Architecture Project»
SAR Concept 2025

Project

«Architecture Methodology»
Mission Threads

«Architecture Methodology»
NAFv4

«Standard»
TOGAF

«Standard»
NAFv4

Information Model
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47 A5 - ARCHITECTURE STATUS 
 

Purpose Usage & Concerns Addressed 
The A5 Viewpoint is concerned with usability and 
approval status of the Architecture Work Products 
which contribute to development and usability of 
the Architecture. 

• Architecture Management & Review. 
• Architecture project management. 
• Release scheduling. 

 
Scope 
• Shall contain Architecture Work Products with their Architecture Status. 
• May show Architecture Descriptions that relate to Architecture Work Products. 
• May show Views that are contained in Architecture Work Products or Descriptions. 

 
Representation 
• Tabular. 
• Text Document. 

47.1 A5 NAF IM Viewpoint 

 

Architecture Status

Architecture Description

Architecture Work
Product

describes

is a kind of

View
contains
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47.2 A5 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Description # Architecture Description Product 
Architecture Status # Architecture Status Business object 
Architecture Work Product # Architecture Work Product Product 
View # View Representation 

 

47.3 A5 Implementation Guidance 

Architecture Work Products are represented as products that can be specialized by an Architecture 
Description. An Architecture status is represented as a business object that is associated with the 
Architecture Work Product. 
The Architecture Description and the Architecture Work Product can aggregate a View represented as a 
representation. 

# Architecture
Work Product# View

# Architecture
Description

# Architecture
Status
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47.4 A5 ArchiMate Example 

 

«Architecture Description»
SAR Concept 2025 Model

«View»
P2 - SAR SIC

Deployment

«View»
P2 - SAR Resource

Structure

«Architecture Work Product»
SAR Concept 2025

«Architecture Status»
Draft

«Architecture Status»
Approved

«Architecture Status»
Completeness: 50%

«Architecture Status»
Maturity: Level 3

«Architecture Status»
Completeness: 100%

«Architecture Status»
Maturity: Level 5
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48 A6 - ARCHITECTURE VERSIONS 
 

Purpose Usage & Concerns Addressed 
The A6 Architecture Versions Viewpoint is 
concerned with version history of the Architecture 
Work Products. 

• Architecture Management. 
• Configuration Control of Architectures. 

 
Scope 
• Shall contain Architecture Versions and relating Architecture Work Products. 
• Shall contain the temporal succession of the Architecture Work Product Versions. 
• May show Architecture Baselines relating to Architecture Work Products and Architecture Versions. 

 
Representation 
• Tabular. 
• Text document. 

48.1 A6 NAF IM Viewpoint 

 

48.2 A6 ArchiMate Viewpoint 

 

Architecture Baseline

Architecture Work
Product Architecture Version

has

is a kind of

supersedes

has

# Architecture
Work Product

# Baseline

# Version
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NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Baseline # Baseline Plateau 
Architecture Version # Version Plateau 
Architecture Work Product # Architecture Work Product Product 

 

48.3 A6 Implementation Guidance 

Architecture Work Products are represented as products. An Architecture Version is represented as a 
plateau with the specialism # Version. The # Version aggregates the Architecture Work Product and 
triggers other # Versions.  
Baselines are represented as plateaus that can specialize the # Version and aggregate the Architecture 
Work Product. 

48.4 A6 ArchiMate Example 

 

«Architecture Description»
SAR Concept 2030 Draft

«Architecture Description»
SAR Concept 2030

«Architecture Description»
SAR Concept 2025 Model

«Version»
Version 1.8

«Version»
Version 1.9

«Version»
Version 2.0

«Baseline»
SAR Concept
2025 Baseline

«Baseline»
SAR Concept
2030 Baseline
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49 A7 - ARCHITECTURE METADATA 
 

Purpose Usage & Concerns Addressed 
The A7 is concerned with the definition of 
Measures and associated criteria supporting 
architecture assessment. 

• View discovery. 
• Architecture discovery. 
• Quality assurance. 
• Architecture element attributes. 

 
Scope 
• Shall contain Measures relevant for the architecture assessment. 
• May show Measures organized into Measure Groups, and their groupings. 
• May show Libraries hosting Measure Groups and Measures. 
• May show Measures to Standards and the Standards' groupings. 
• May show Desired Metrics and Achieved Metrics that the Measures govern. 

 
Representation 
• Tabular. 
• Diagram. 

49.1 A7 NAF IM Viewpoint 

 

Achieved Metric Desired Metric

MeasureMeasure Group

Library

Standard
specifies

governs

aggregates

aggregates

governs

aggregates

hosts

hosts

Architecture Description

assesses
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49.2 A7 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Achieved Metric # Achieved Metric Business object 
Architecture Description # Architecture Description Product 
Desired Metric # Desired Metric Business object 
Library # Library Grouping 
Measure # Measure Business object 
Measure Group # Measure Business object 
Standard # Standard Contract 

 

49.3 A7 Implementation Guidance 

Measures are represented as business objects with the specialism # Measure. 
Measure Groups are represented as # Measures that can aggregate other # Measures.  
Achieved Metrics and Desired Metrics are represented as business objects that can be associated with the 
# Measure.  
Libraries are represented as groupings that can aggregate the # Measure.  
Standards are represented as contracts that can be associated with the # Measure and can aggregate 
themselves.  
The Architecture Description is represented as a product that can be associated with the # Measure. 

# Achieved Metric # Desired Metric

# Standard

# Architecture
Description

# Measure# Library
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49.4 A7 ArchiMate Example 

 
«Architecture Description»
SAR Concept 2025 Model

«Standard»
ISO 42010

«Standard»
NAFv4

Information Model

«Achieved Metric»
Conformant

«Achieved Metric»
Compliant

«Desired Metric»
Partially Conformant

«Desired Metric»
Compliant

«Measure»
Conformance

«Measure»
Compliance



 147 NAFv4.1 ArchiMate 

50 A8 - ARCHITECTURE STANDARDS 
 

Purpose Usage & Concerns Addressed 
The A8 Standard Viewpoint specifies the Profiles, 
Standards and Constraints (rules, policy and 
guidance) that are applicable to aspects of the 
architecture. These Standards may be traced to 
elements elsewhere in the architecture to indicate 
that those elements conform to the applicable 
NATO and/or international Standards. 

• Project Strategy. 
• Project Governance. 
• Application of standards (informing project 
strategy). 
• Standards compliance. 
• Forecasting future changes in standards 
(informing project strategy). 
• Specifying standards that will have an impact on 
the architecture and the capability it is to deliver. 

 
Scope 
• Shall contain the Standards used throughout the architecture. 
• May show Standards in Standard Groups, and their groupings. 
• May show Profiles which reference Standards and other Profiles. 
• May show Architectural Constraints that the Profiles include. 
• May show Libraries hosting Profiles and Standard Groups. 

 
Representation 
• Tabular. 
• Diagram. 

50.1 A8 NAF IM Viewpoint 

 

Standard

Standard Group

Profile Library

Architectural Constraint

aggregates

references

aggregates

aggregates

hosts

hosts

references

includes

is a kind of
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50.2 A8 ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architectural Constraint # Architectural Constraint Requirement 
Library # Library Grouping 
Profile # Profile Contract 
Standard # Standard Contract 
Standard Group # Standard Contract 

 

50.3 A8 Implementation Guidance 

Standards are represented as contracts. They can aggregate and specialize other Standards. 
Profiles are represented as contracts that are associated with a Standard and associated with other 
Profiles. 
Architectural Constraints are represented as requirements that are associated with a Profile.  
Libraries are represented as groupings that can aggregate Standards and Profiles. 

# Standard

# Architectural
Constraint

# Profile

# Library
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50.4 A8 ArchiMate Example 

 

«Architectural Constraint»
Device Support for Aid

Community Document Upload

«Architectural Constraint»
FMN Support UNCLAS

information Services

«Standard»
FMN Spiral Group

«Standard»
Federated Mission Networking -

Spiral 6

«Profile»
FMN MPE FMCN Information

Sharing Guidebook
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51 AR - ARCHITECTURE ROADMAP 
 

Purpose Usage & Concerns Addressed 
The Ar Architecture Roadmap Viewpoint is 
concerned with the evolution timeline for an 
Architecture to meet the goals of the enterprise. 

• Architecture Project Management. 
• Developing architectures. 

 
Scope 
• Shall contain Architecture Statuses of Architecture Work Products. 
• Shall contain Architecture Milestones that define the Architecture Status. 
• May show Architecture Projects that schedule a Milestone and define the evolution of an Architecture 
Status. 
• May show Architecture Versions of the Architecture Work Product. 
• May trace Architecture Milestones to other row-specific Milestones they correspond to. 

 
Representation 
• Timeline view. 
• Augmented chart in style of a Gantt Chart. 

51.1 Ar NAF IM Viewpoint 

 

Architecture Work
Product

Architecture Version

Architecture Status

Enterprise Phase

Architecture Milestone

defines

corresponds to

has

describes

Architecture Project

defines evolution of

schedules

Logical Milestone

Resource Milestone

corresponds to

corresponds to
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51.2 Ar ArchiMate Viewpoint 

 
 

NAF IM Element NAF ArchiMate Specialism ArchiMate Element 
Architecture Milestone # Architecture Milestone Implementation event 
Architecture Project # Architecture Project Work package 
Architecture Status # Architecture Status Business object 
Architecture Version # Version Plateau 
Architecture Work Product # Architecture Work Product Product 
Enterprise Phase # Enterprise Phase Plateau 
Logical Milestone # Milestone Implementation event 
Resource Milestone # Milestone Implementation event 

 

51.3 Ar Implementation Guidance 

Architecture Work Products are represented as products. Architecture Statuses are represented as 
business objects that are associated with the Architecture Work Product. Architecture Milestones are 
represented as milestones and are associated with the Architecture Status. 
Versions are represented as plateaus that can aggregate the Architecture Work Products.  
Architecture Products are represented as work packages and they can realize the # Architecture Status and 
be associates with the # Architecture Milestone. The # Architecture Milestone can be associated with the # 
Enterprise Phase (represented as a plateau and defined in the Cr) and specialize # Milestones defined in the 
Cr, Lr and Pr viewpoints. 

# Architecture
Work Product

# Enterprise
Phase

# Milestone# Architecture
Milestone

# Architecture
Project

# Architecture
Status

# Version
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51.4 Ar ArchiMate Example 

 
  

«Version»
Version 1.9

«Architecture Work
Product»

SAR Conceptual Design

«Architecture Status»
Completeness: 60%

«Architecture
Milestone»

SAR Concept
Review

«Architecture Project»
SAR Concept 2025 Project

«Enterprise
Phase»

Horizon 2030

«Milestone»
SAR New C2

«Milestone»
SAR C2

Configuration
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52 GLOSSARY 
 

NAFv4 ArchiMate 
Name 

Description 

# Achieved Metric A value for a [Metric] observed or measured for a specific Entity of Interest. 
# Actor An entity or party that actively performs or contributes to an activity, action or 

task. 
# Application An identifiable, technology‑specific or product‑based deployed and operational IT 

system within the organisation. Typically a line‑of‑business application used to 
deliver defined functionality in order to support Operational Activities, Business 
Processes or other Applications. 

# Application 
Function 

Internal application behaviour that may take the form of a specific task, action, or 
activity, or a broader collection of related activities needed to achieve a desired 
outcome. 

# Application 
Interface 

Exposes an Application Service for consumption. 

# Application 
Operation 

Enables programmatic communication with an Application Service via an 
Application Service Interface. 
 

# Application 
Process 

A specific task, action, or activity performed by an Application. 

# Application 
Resource State 

A [State] specified for an Application Resource 

# Application 
Service 

Exposes application‑level behaviour or value to its consumers. It delivers value, 
functionality or a product in a standardised and contracted way, while hiding the 
underlying application logic, data structures and constraints. 

# Application State A functional condition of a   Logical Application at a point in time. 
# Architectural 
Constraint 

An architectural limitation, restriction or boundary condition that a solution to a 
problem must satisfy. 

# Architecture 
Description 

A work product used to express an [Architecture 

# Architecture 
Description 
Element 

An identified or named part of an [Architecture Description] . 

# Architecture 
Methodology 

A defined set of methods and processes used to create, analyse, and manage 
architectures. 

# Architecture 
Milestone 

A [Milestone] in a project which predicts or delivers or decommissions one or 
more [Architecture]s. 

# Architecture 
Project 

An activity for the delivery of an [Architecture]. 

# Architecture 
Status 

The current state or shape that an [Architecture] is in. 

# Architecture 
Work Product 

A tangible outcome of architectural work. 

# Artifact A piece of data that is used or produced in a software development process, or by 
deployment and operation of an IT system. 

# Assessment 
Criteria 

A specification of what is expected to be fulfilled by the future realization of a 
[Capability] (example: system or resource). 

# Baseline The approved version of an [Architecture Work Product] that can be changed only 
through formal change control procedures and is used as a basis for comparison. 
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# Business 
Function 

Internal business behaviour that may take the form of a specific task, action, or 
activity, or a broader collection of related activities/business processes needed to 
achieve a desired outcome. 

# Business 
Interface 

Exposes a Business Service for consumption. 

# Business 
Operation 

Enables programmatic communication with a Business Service via a Business 
Service Interface. 

# Business Process A specific task, action, or activity performed by an Organization, Person or Post 
# Business 
Resource State 

A [State] specified for an Business Resource 

# Business Service Exposes business‑level behaviour or value to its consumers. It delivers value, 
functionality or a product in a standardised and contracted way, while hiding the 
underlying business processes, roles and constraints. 

# Business State A functional condition of a node,   Actor or resource at a point in time. 
# Capability The expected ability of one or more resources to deliver a specified type of effect 

or outcome or a specified course of action. 
# Capability 
Configuration 

A solution building block that combines physical resources (people, technology) 
and implements processes to realize a [Capability]. 

# Capability Group Two or more [Capability]s forming a complete unit in a composition or  
collection. Note: A Capability Group can be structured as a taxonomy.  

# Communication 
Network 

A communication network represents a set of structures that connects devices or 
system software for transmission, routing, and reception of data. 

# Concern A matter of relevance or importance to a stakeholder. 
# Constraint A limitation, restriction or boundary condition that a solution to a problem must 

satisfy.  
# Contextual Data Contextual Data:[Data] describing the environment of surrounding things, 

conditions, or influences upon an entity of interest. 
# Correspondence 
Method 

Method used to govern the [AD Element Correspondence] 

# Data Object Representation of information in a formalized manner suitable for communication, 
interpretation, or processing 

# Desired Metric A value for a [Metric] required for a specific Entity of Interest. 
# Device A device represents a physical IT resource upon which system software and 

artifacts may be stored or deployed for execution. 
# Distribution 
Network 

A physical network used to transport materials or energy. 

# Driver Represents an external or internal condition that motivates an organization to 
define its goals and implement the changes necessary to achieve them over a 
given period of time. 

# Effectiveness 
Criteria 

An operational criterion of effectiveness or success which is specified for a 
[Capability] or an [Effect]. 

# Element 
Correspondence 

:An identified or named relation between two or more architecture description 
elements. 

# Energy concrete and deliverable instance of a resource that provides power, strength or 
force for any kind of purpose. 

# Enterprise Phase A current or future state of the enterprise. 
# Equipment All non-expendable items needed to outfit/equip an  

individual or organization. Can represent real‑world, named physical machines or 
tools. 

# Facility A facility represents a physical structure or environment. 
# Glossary Term The name and definition of a defined concept that appears within an 

[Architecture]. 
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# Goal The aim or objective that a person, group, or organization works towards or strives 
to achieve. 

# Information 
Object 

An item that is derived from one or more sources of Knowledge that is 
exchangeable amongst users, about things, facts, concepts, and so on, in a 
universe of discourse to meet a specific purpose. 

# Interaction An [Interaction] between two or more Services or Active Resources at the Service 
or Logical Layer, conveying Passive or Data Resources 

# Library A collection of artefacts providing information. 
# Logical 
Application 

An identifiable, technology‑agnostic application concept that represents a 
coherent set of intended functionality or system behaviour. Typically used to 
express an abstract or conceptual application or system, independent of specific 
products or implementations, in order to support Business Processes or other 
Applications. e.g. ERP System. 

# Logical Energy An abstract description of a type of energy resource used or transformed within 
the system. Logical Energy represents a general category of energy flow or supply, 
such as electrical power, fuel, thermal energy, or hydraulic pressure, without 
identifying any specific source, medium, storage unit, or physical implementation. 

# Logical 
Equipment 

The conceptual category or kind of equipment or infrastructure, representing a 
high‑level type without referencing a specific real‑world model or variant. E.g. 
Tent, Helicopter, Jet Plane or Snowmobile 

# Logical Event An external trigger to start a [sequence of] Interaction[s] at the logical level. 
Example: Casualty at the point of injury. 

# Logical Lifeline A linear representation of the course of a logical entity's life. 
# Logical Material An abstract description of a type of material resource used, consumed, created, or 

moved within the system. Logical Material represents a general category of 
physical substance or item, such as water, ammunition, medical supplies, or raw 
materials, without identifying any specific batch, container, form factor, or 
physical implementation. 

# Logical 
Specification 

An information part that identifies, in a complete, precise and verifiable manner, 
the requirements, design, behaviour, or other expected characteristics of an entity 

# Logical 
Technology 

An abstract description of a kind of machine, equipment, or IT‑related element 
developed from scientific or engineering knowledge. Logical Technology expresses 
a general category of software, hardware, firmware, or technical infrastructure 
without identifying any specific product or implementation. 

# Material A concrete and tangible piece of physical matter. 
# Measure A unit used for stating a numerical or categorical attribute of an entity of interest. 
# Metadata [Data] that describe other [Data]. 
# Milestone A significant stage or event in the progress or development of something.  
# Mode A functional condition of an activity or function at a point in time. 
# Needline A relationship specifying the need to exchange information between [Node]s. 
# Node A placeholder for an aggregate of logical resources and behaviour (including:  

organizations, equipment, technology, material, information, activities etc)  
that together perform specific activities and/or functions.  

# Operational 
Activity 

A logical process, specified independently of how it is carried out. 

# Operational Flow An exchange of information, material, people, energy or another [Resource] 
between two [Operational Activity]s. 

# Organization An organized group of people with a particular purpose such  
as a business, government department or team. 

# Outcome The outcome which a person, group, or organization works towards or strives to 
achieve. 

# Person A human as an individual, being used to define the  
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characteristics needed.  
# Post The type of job title or position that a person can fill.  

Example: Chief Executive Officer, Lawyer, Machine Operator,  
Cook.  

# Profile A set of one or more standards, with one or more constraints and implementation 
guidance to support development and operation. 

# Protocol A kind of [Standard] specifying how two entities communicate or interact with 
each other.  

# Rationale A reason behind a rule or [Constraint]. 
# Readiness Level A measured willingness or state of being prepared for something, described as a 

defined and stable condition that indicates the current state of readiness within 
the architecture. 

# Requirement A statement which specifies an expectation that a solution shall fulfil. 
# Resource Event An [Event] specified at the resource level. 
# Resource 
Interaction 

A [Resource Interaction] between two or more Active Resources at the physical 
layer, conveying Passive and/or a exchange of data, material, people, energy or 
another [Resource] between two [Resource]s. 

# Resource Lifeline A [Lifeline] specified at the resource level. 
# Resource Mode A [Mode] specified at the resource level. 
# Resource State 
Transition 

A change from one [Resource State] to another. 

# Role Represents the responsibility or characteristics that an Actor plays in a particular 
activity, process or interaction.  

# Service Function 
Parameter 

A constant or variable passed into or out of a [Service Interface] as part of the 
execution of a [Service Function]. 

# Service Group Two or more [Service]s forming a complete unit in a collection. 
# Service 
Operation 
Parameter 

A constant or variable passed into or out of a [Service Interface] as part of the 
execution of a [Service Operation]. 

# Service Policy A set of rules and constraints that specify the non-functional aspects of a [Service]. 
Examples: Availability, Reliability, Safety, Security, Useability.  

# Stakeholder Individual or organization having an interest in an entity or a course of action. 
Adapted from ISO 15288 

# Standard A document developed by consensus of different parties and approved by a 
recognized body with the objective to maximize compatibility, interoperability, 
safety, repeatability, or quality. 

# State Transition A change from one [Service State] to another. 
# System Software System software represents software that provides or contributes to an 

environment for storing, executing, and using software or data deployed within it. 
# Technology 
Function 

Internal technology behaviour that may take the form of a specific task, action, or 
activity, or a broader collection of related activities needed to achieve a desired 
outcome. 

# Technology 
Interface 

Exposes a Technology Service for consumption. 

# Technology 
Operation 

Enables programmatic communication with a Technology Service via a Technology 
Service Interface. 

# Technology 
Process 

A specific task, action, or activity performed by Physical or Technical Resource. 

# Technology 
Resource State 

A [State] specified for a Technology Resource. 
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# Technology 
Service 

Exposes technology‑level behaviour or value to its consumers. It delivers value, 
functionality or a product in a standardised and contracted way, while hiding the 
underlying technology, infrastructure and operational constraints. 

# Technology State A functional condition of  Logical Technology at a point in time. 
# Value Stream Represents a sequence of activities that create an overall result for a customer, 

stakeholder, or end user. 
# Version An identifiable form of an [Architecture] differing in certain respects from an 

earlier form. 
# View An Information part comprising a portion of an architecture description. 
# Viewpoint A set of conventions for the creation, interpretation and use of an architecture 

view to frame one or more concerns. 
# Work Package A Work Package represents a project or programme activity that organizes, 

manages, and delivers changes required to realize a Capability Increment. It 
schedules and coordinates Milestones and may realize part or all of a Capability. 
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